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What NX Studio Can Do for You
NX Studio is used to view and enhance photos and videos shot with Nikon digital 

cameras. It offers a user-friendly way of performing these tasks on pictures after 

download. It also offers other ways to enjoy your pictures, for example uploading 

them to the Web or viewing shooting locations on a map.

Basic Features
NX Studio is used to view and enhance pictures downloaded to your computer via 

Nikon Transfer 2 or the like. It can also be used to print pictures or upload them to 

the Web after enhancement.

 ❚ Viewing Pictures (0 33)
You can view pictures in a thumbnail display and quickly find the one you 

want. Selected pictures can be viewed single-frame at a larger size to check 

fine details. You also have a choice of multi-frame views that can be used to 

compare pictures side-by-side. You can also compare before-and-after views of 

the same picture to assess the effects of adjustments.

 ❚ Filters (0 64)
Pictures can be filtered by rating and label. Quickly find the pictures you want 

for a more efficient workflow.

 ❚ Enhancing Pictures (0 81)
Photos can be enhanced in a variety of ways, including by adjusting brightness, 

hue, and other settings, cropping pictures, or processing RAW images and 

saving the results in other formats.

 ❚ Exporting Pictures (0 258)
Pictures that have been enhanced or resized can be exported in JPEG or TIFF 

format. The exported pictures can then be opened using other software.
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 ❚ Uploading Pictures to the Web (0 241)
Upload pictures to NIKON IMAGE SPACE or YouTube.

 ❚ Printing (0 248)
Print pictures and give them to friends and family.

Advanced Features
NX Studio can be used not only to enhance photos, but also to edit videos. Location 

data embedded in pictures can be used to display shooting locations on a map.

 ❚ Video Editing (Movie Editor) (0 161)
Trim unwanted footage or splice clips together.

 ❚ Location Data (0 198)
Location data embedded in pictures can be used to display shooting locations 

on a map. You can also import track logs and add location data to pictures.

 ❚ Slide Shows (0 236)
View a slide show of the pictures in a selected folder.

 DAvailable Features

Some features may not be available depending on the country or region of use.
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The NX Studio Workflow
NX Studio can handle everything from downloading and displaying pictures from 

your camera to enhancing your favorite shots and uploading them to the Web.

Step 1: Launch NX Studio
Launch NX Studio as described below.

• Windows: Double-click the NX Studio icon on the desktop.

• macOS: Go to the Launchpad and click the NX Studio icon in the “Nikon Software 

(Other)” folder.

Step 2: Download Pictures to Your Computer
You can readily download photos and videos from your camera using Nikon 

Transfer 2 software installed with NX Studio.

https://crossgate.nikonimglib.com/dsd_redirect/redirect.do?P=7ToiP61&R=U4Ni269&L=1hUBI04&O=UQFpn00
https://crossgate.nikonimglib.com/dsd_redirect/redirect.do?P=7ToiP61&R=U4Ni269&L=1hUBI04&O=UQFpn00
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Step 3: View Pictures
NX Studio offers a variety of options for viewing the downloaded pictures and 

quickly finding the one you’re looking for (0 “Viewing Pictures”, page 33, and 

“Filters”, page 64).

Step 4: Enhance Pictures
Adjust brightness, hue, and other settings. NX Studio’s intuitive controls help you 

get the results you want (0 “Enhancing Pictures”, page 81).
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Step 5: Export Pictures
After enhancing pictures, you can save them as JPEG or TIFF files under new names. 

The pictures can then be used with other software.
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Step 6: Upload or Print Pictures
Pictures that have been saved in the appropriate formats can be uploaded to NIKON 

IMAGE SPACE or YouTube (0 “Uploading Pictures to the Web”, page 241). You can 

also print pictures and share them with family and friends (0 “Printing”, page 248).

NX Studio also offers many other ways to enjoy your photos and videos. For more 

information, see “What NX Studio Can Do for You” (0 “What NX Studio Can Do for 

You”, page 8).
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The NX Studio Window
The elements of the NX Studio window are shown below.

 The Menu Bar
Select menu options (0 “Menu List”, page 288).

 The Toolbar
Launch Nikon Transfer 2 or other software, print pictures, or perform other tasks.

 The Browser Palette
Select folders in the [Folders] list, view frequently-used folders you’ve added to 

[Favorite Folders], or browse [Albums], personalized collections of frequently-

viewed photos.

 The View Area
Pictures are displayed here (0 “Viewing Pictures”, page 33).

 The Adjustments/Info Palette
Shows image information and adjustments for the selected pictures.
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The Toolbar

 View/Hide Toolbar
Click to view or hide the toolbar.

 [Import]
Launch Nikon Transfer 2.

 [Edit Video]
Edit videos (0 “Video Editing (Movie Editor)”, page 161).

 [Other Apps]
Open selected pictures using other software. Software can be added via 

[Options] > [Open with Application] (0 “[Open with Application]”, page 

273).
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 [Slideshow]
View the pictures in the current selection or current folder as a slide show 

(0 “Slide Shows”, page 236).

 [Print]
Print the pictures in the current selection (0 “Printing”, page 248).

 [Upload]
Upload the pictures in the current selection to NIKON IMAGE SPACE or YouTube 

(0 “Uploading Pictures to the Web”, page 241).

 [Export]
Export the pictures in the current selection in JPEG or TIFF format. Options 

available during export include resizing pictures and removing image 

information (0 “Exporting Pictures”, page 258).

 A Toolbar Display Options

• To display the tools in the toolbar as icons without text, select [Customize 
Toolbar] > [Icon only] in the [Window] menu. Use [Customize] to choose 

the tools displayed.

• If installed, NX Tether can be launched by clicking [Remote Photography] in 

the toolbar.
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The Browser Palette
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 [Navigation]
A small image showing pictures displayed in the view area in single- or multi-

frame view.

• A frame shows the area visible when the picture is zoomed in.

• Drag the frame to scroll the display in the view area to a different area of the 

image.

 [Favorite Folders]
Add folders to favorites by dragging them in from the [Folders] list.
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 [Folders]
A hierarchical display of the folders on the computer. Click folders to display the 

pictures they contain in the view area.

 [Albums]
Create and manage albums. Use albums to organize pictures across folders 

(0 “Collecting Pictures in Albums”, page 21).

 View/Hide
Click to view or hide the browser palette.
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 AViewing and Hiding Sub-Palettes

The [Navigation], [Favorite Folders], [Folders], and [Albums] sub-palettes can 

be viewed or hidden by clicking the /  buttons at their top left corners.

 A Resizing Sub-Palettes

Drag the borders between the [Navigation], [Favorite Folders], [Folders], and 

[Albums] sub-palettes to adjust their size.
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 ❚ Collecting Pictures in Albums
Organize pictures by theme. Using albums to collect pictures from multiple folders 

can help you quickly find the shot you want.

1. To create a new album, click  and enter the album name.

2. Display the filmstrip (0 “Filmstrip View”, page 47) or select the thumbnail 

grid or thumbnail list view in the view area (0 “Choosing a View Mode”, page 

36).
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3. Drag and drop pictures into the album created in Step 1.

 A Selecting Multiple Pictures for Drag-and-Drop

Multiple pictures can be selected for drag-and-drop using the control (or in 

macOS, the command) or shift key.

4. Add pictures from other folders.
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5. Click the album name to view the pictures added to the album in Steps 3 and 4.

 AAlbums

• Folders cannot be created in albums.

• Albums do not support sort or filter operations.

• Pictures in albums are stored in their original folders and are not copied or 

moved into the albums.

• To delete an album, right-click (or in macOS, control-click) the album and 

select [Delete Album].
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The Adjustments/Info Palette



25The NX Studio Window

 [Histogram]
The histogram for the current picture. To view or hide the histogram, click the 

/  button.

• The channel and brightness can be selected from the pull-down menu.

• Select [RGB] to display the histograms for all three channels, [R] (red), 

[G] (green), and [B] (blue), overlaid with each other. Regions where the 

histograms overlap are shown in other colors. [G] and [B] overlaps are shown 

in cyan, [R] and [B] overlaps in magenta, and [R] and [G] overlaps in yellow. 

Regions where all channels overlap are shown in white.
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 The [Adjustments] Tab
Enhance the current picture. Among the many adjustments on offer are 

cropping and straightening tools and tools for adjusting such parameters as 

exposure, white balance, and brightness (0 “Enhancing Pictures”, page 81).
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 The [Info] Tab
View information on the current picture, including the camera model name, 

date of recording, and exposure.
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 AView Mode

The display in the [Info] tab changes with each press of the view mode button.
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 The [XMP/IPTC] Tab
Edit XMP/IPTC metadata, including labels and ratings. Changes to labels and 

ratings in the view area or [Image] menu are reflected in the [XMP/IPTC] tab.
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 View/Hide
Click to view or hide the adjustments/info palette.
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Supported Formats
NX Studio supports the file types listed below.

Image Files
NX Studio supports the following formats for still images shot with Nikon digital 

cameras or saved using Nikon software:

• RAW pictures in NEF and NRW formats (extensions “.nef” and “.nrw”)

• JPEG (extensions “.jpg” and “.jpeg”), RGB mode only; CMYK mode and JPEG 2000 

not supported

• TIFF (extensions “.tif” and “.tiff”), RGB mode only; CMYK mode not supported; 

editing available only with uncompressed files or files compressed using LZW

• MPO (extension “.mpo”)

 AViewing RAW Pictures

In the case of RAW pictures edited using plug-ins in the Nik Color Efex Pro series 

or created or edited using optional Picture Controls not installed with NX Studio, 

NX Studio will display only the previews embedded in the images, not the 

pictures themselves. Editing and export are not supported.

Video Files
NX Studio supports the following formats for videos shot with Nikon digital cameras 

or saved using Nikon software:

• AVI, a common Windows format (extension “.avi”)

• Quicktime (extension “.mov”)

• MPEG -4 (extension “.mp4”)
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 D Cautions: MOV Format

• NX Studio may be unable to play some MOV videos depending on the video 

file type.

• Colors in HLG and N-Log videos will not display correctly.

• NX Studio cannot be used to color grade N-Log videos.

Audio Files
NX Studio supports the following format for audio files appended to pictures as 

voice memos and for voice recordings created with COOLPIX cameras:

• WAV (extension “.wav”)

Image Dust Off Reference Data
NX Studio supports the following format for Image Dust Off reference data recorded 

using Nikon digital SLR and mirrorless cameras (0 “The Camera Corrections Tool”, 

page 144):

• NDF (extension “.ndf”)

Track Logs
NX Studio supports track logs in the following formats (0 “Importing Track Logs”, 

page 220):

• NMEA (extensions “.nmea”, “.nma”, and “.log”)

• GPX (extension “.gpx”)

• Altitude logs (extension “.lga”)

• Depth logs (extension “.lgb”)
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Viewing Pictures

0 The View Area

0 Choosing a View Mode

0 Filmstrip View

0 Full-Frame View

0 Viewing Videos

0 The Bottom Toolbar

0 Viewing Pictures Side-by-Side
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The View Area
Pictures are displayed in the view area. You have a choice of view modes, including 

not only thumbnail and single-frame display, but also side-by-side and before-and-

after-editing comparison views.

 View Mode
Choose how pictures are displayed in the viewer. You have a choice not only of 

thumbnail, map, and single-frame views, but can also compare pictures side-by-

side (0 “Choosing a View Mode”, page 36).

 Filmstrip View
Display a filmstrip (a row or column of thumbnails) below or to the left of the 

viewer (0 “Filmstrip View”, page 47).

 Full-Frame View
Display pictures full-screen (0 “Full-Frame View”, page 49).
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 Filter
Limit the display of thumbnails in the view area or filmstrip using one or more 

filters (0 “Filters”, page 64).

 Sort
Sort thumbnails in the view area or filmstrip.

 Display Size
Choose the thumbnail or picture display size (0 “Thumbnail Size”, page 42, 

“Choosing a Display Size”, page 46).

 Viewer
View the current picture.

 The Bottom Toolbar
Display shooting data in the viewer and rate or label pictures (0 “The Bottom 

Toolbar”, page 54).
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Choosing a View Mode
Choose a view mode in the top toolbar.

Thumbnail Grid ( )
List the pictures in selected folders.
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 ❚ Photo Thumbnails
The meanings of the icons and other data displayed on photo thumbnails are 

described below. Depending on the thumbnail size, some data may not be 

displayed.

 Rating
The photo’s current rating. You can add ratings to unrated photos by mousing 

over the thumbnail (0 “Rating Pictures”, page 66).

 Label
The picture’s current label. You can add labels to unlabeled photos by mousing 

over the thumbnail (0 “Labeling Photos”, page 70).

 Protection
Displayed on protected pictures. You can add or remove protection by mousing 

over the thumbnail (0 “Protecting Pictures”, page 74).

 File Name
The file name. Files that have yet to be saved after editing are indicated by an 

asterisk (“*”) in front of the file name.
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 Enhancement
Displayed on pictures to which enhancements have been applied.

• : Displayed on pictures to which enhancements have been applied in the 

[Adjustments] tab (0 “Enhancing Pictures”, page 81).

• : Displayed on pictures that have been enhanced using Capture NX 2.

• : Displayed on pictures that have been enhanced using plugins in the Nik 

Color Efex Pro series.

• : Displayed on pictures that have been retouched on the camera.

 RAW + JPEG
Displayed on pictures shot in RAW + JPEG format.

 Group Member
Displayed on pictures that are grouped with voice memos or other files.

• : Displayed on pictures with voice memos.

• : Displayed on the best shots in sequences shot with the Smart Photo 

Selector.

• : Displayed on best shot candidates in sequences shot with the Smart Photo 

Selector.

• : Displayed on Motion Snapshots.

• : Displayed on 3D MPO pictures.

 Location Data
Indicates the presence of embedded location data (0 “Location Data”, page 

198).

 Image Area
Displayed on pictures taken using cameras with an image area option. No icon 

is displayed on pictures shot in FX format, while the icons displayed on other 

pictures vary with the option selected for image area. Some examples are 

shown below.

• : Photo taken at image area settings with an aspect ratio of 3:2.

• : Photo taken at an image area setting of 5:4 (30 × 24).

• : Photo taken at an image area setting that increases the apparent focal 

length of the lens by 1.2×.
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 ❚ Video Thumbnails
The meanings of the icons and other data displayed on video thumbnails are 

described below. Depending on the thumbnail size, some data may not be 

displayed.

 ProRes
Displayed on videos recorded using the ProRes codec.

 Length
The length of the video. Not displayed on videos recorded using the ProRes 

codec.

 Rating
The video’s current rating. You can add ratings to unrated videos by mousing 

over the thumbnail (0 “Rating Pictures”, page 66).

 Protection
Displayed on protected videos. You can add or remove protection by mousing 

over the thumbnail (0 “Protecting Pictures”, page 74).
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 File Name
The file name. Files that have yet to be saved after editing are indicated by an 

asterisk (“*”) in front of the file name.

 AF Noise Reduction
Displayed on videos that have been processed using the [AF Noise Reduction] 

option in the [Image] menu to reduce the sound made by the camera focusing.

 Video
Displayed on videos.

 Location Data
Indicates the presence of embedded location data (0 “Location Data”, page 

198).

 Image Area
Displayed on videos taken using cameras with a video crop selection option. 

The icon displayed varies with the selected crop. Some examples are shown 

below.

• : Video recorded using a crop with an aspect ratio of 3:2.

• : Video recorded using a DX-format crop that increases the apparent focal 

length of the lens by 1.3×.

• : Video recorded using a crop that increases the apparent focal length of 

the lens by 3×.

 Tone Mode
Displayed on videos recorded with N-Log or HLG selected for tone mode.
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Thumbnail List ( )
List the pictures in selected folders. Pictures can be sorted by filename, label, or 

other criteria.
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 A Thumbnail Size

The size of the thumbnails in the list and grid displays can be adjusted using 

the slider at the top right corner of the view area. Sliding the slider to the right 

increases thumbnail size.

 A The Thumbnail List

To choose the categories shown in the thumbnail list view, click the  at the top 

right corner of the view area.
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Map ( )
With the help of web map services, you can generate maps with icons showing 

where pictures were taken based on location data embedded in the shots at the 

time of recording. You can also add location data to pictures based on track logs 

(0 “Location Data”, page 198).

Image Viewer ( )
Display pictures in single-frame view.
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2 Images ( )
Compare two pictures side-by-side (0 “2 Images/4 Images”, page 59).

4 Images ( )
Compare four pictures at once (0 “2 Images/4 Images”, page 59).
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Before and After ( )
Compare enhanced pictures with the same pictures pre-enhancement (0 “Before 

and After”, page 62).
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 A Choosing a Display Size

Use the buttons at the top right corner of the view area to choose the display size 

for pictures in the image viewer, “2/4 images”, and before-and-after displays.

 Fit: Click to view the entire image at the current fit. The fit can be selected by 

clicking .

• [Fit to Screen]: Fit the picture to the viewer.

• [Fit to Square]: Fit the picture to a square inscribed inside the viewer.

• [Fit Short Edge to Screen]: Fit the short edge of the picture to the viewer. 

The zoom ratio will not exceed 100%.

 100%: View the picture at 100% zoom.

 Zoom ratio: Choose a zoom ratio from the menu.

 Zoom in/zoom out: Zoom the picture in or out. Choose from zoom ratios of 6 

to 400 percent.

 A 100% Zoom

You can also click the picture in the viewer to display it at 100% zoom. You also 

have the option of mousing over the picture and holding the shift key to zoom 

temporarily to 100%.
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Filmstrip View
Select ( ) the  button in the top toolbar to view a row or column of thumbnails 

(the “filmstrip”) below or to the left of the viewer in the map, image viewer, “2/4 

images”, and before-and-after displays.
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You can change the orientation of the filmstrip by clicking . The orientation is 

reflected in the icon for the filmstrip tool, which changes to  when the filmstrip is 

displayed below the viewer and to  when it appears to the left.

Filmstrip displayed to left of viewer
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Full-Frame View
Select ( ) the  button in the top toolbar to view the current picture full-screen.
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• Double-clicking a picture in the thumbnail grid or list view displays it full-frame in 

the viewer.

• Double-clicking a picture in map, image viewer, “2/4 images” or before-and-after 

view displays it full-frame in the selected view.

Picture displayed full-frame in the “2 images” view

• The viewer toolbars can be displayed by mousing over the top or bottom of the 

screen. Click  to exit full-frame view (the button will change to ). You can also 

exit full-frame view by pressing the escape key.
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Viewing Videos
NX Studio can be used to play videos selected for display in single-frame view. 

Mousing over the viewer displays video playback controls.

Video Playback Controls

 Frame-by-Frame Display
Click to view the individual frames of the video as thumbnails. Drag the handles 

at either side to scroll to the desired frame (0 “Removing Unwanted Footage”, 

page 164).

 Playback Position
The current playback position.

 Playback Slider
Shows the current playback position. Drag the slider to fast-forward or rewind.
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 Length
The total length of the current video.

 Save Still
Save a still of the current frame.

 Frame Rewind/Frame Advance
Rewind or advance the video a frame at a time. Clicking either button during 

playback pauses the video, after which it can be rewound or advanced a frame 

at a time starting at the selected position.

 Play/Pause
Start, pause, or resume playback.

 Mute
Toggle this button to  to mute audio. Click again to enable audio.

 D Installing Video Codecs (Windows Only)

Depending on the file type, you may be prompted to install a video codec when 

attempting to display videos in the image viewer ( ). Follow the on-screen 

instructions to install the codec.
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 AVideo Stills

To save the current frame as a still, click the “Save Still” button ( ) in the video 

playback controls.

• Select [Settings] > [Simple Settings] to save the still at the default 

compression and frame size.

• To choose a different compression and frame size, select [Settings] > 

[Advanced Settings].

• To choose the destination folder, select [Save in] > [Specified folder].

• A file name can be entered in the [File Name] field.
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The Bottom Toolbar
Use the toolbar at the bottom of the view area to display shooting data and rate or 

label pictures.

 Show RAW and JPEG Pairs as Single Images
Select ( ) this tool to display each pair of pictures shot in RAW + JPEG format as 

a single image in thumbnail and filmstrip views.

 Show Sequences as Single Images
Select ( ) this tool to display each sequence of pictures shot using the Smart 

Photo Selector or in continuous release mode as a single image in thumbnail 

and filmstrip views.
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 Focus Point
Select ( ) this tool to display the location of the focus point for the current 

picture.

• The focus point can be displayed on any picture taken with a COOLPIX A or 

with a CPU lens attached to a Nikon digital SLR or mirrorless camera.

• It is displayed in thumbnail, single-frame, and multi-frame views.

 D The Focus Point Display

• The point shown may differ from the actual focus point if the composition 

was changed using focus lock after the camera had focused.

• The focus point may not be displayed at all if focus failed when the picture 

was taken.

 ANo Focus Point

The focus point is not displayed on pictures that:

• have been cropped or straightened,

• have been resized,

• have been saved after being rotated,

• were shot with a non-CPU lens,

• were taken in manual focus mode, or

• have been edited using other software.
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 Show Grid
Select ( ) this tool to display a grid in the viewer.

 Image Information
Select ( ) this tool to display the camera name, date of recording, and other 

image information in the viewer.
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 Histogram
Select ( ) this tool to display a histogram in the viewer. Click  and choose a 

histogram from the pull-down menu.

 Rotate
Click to rotate the pictures in the current selection clockwise or 

counterclockwise.

 Rating
Rate pictures (0 “Rating Pictures”, page 66).

 Label
Label pictures (0 “Labeling Photos”, page 70).

 Protect
Protect or remove protection from pictures (0 “Protecting Pictures”, page 74).
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 Current Color
The color of the pixel under the cursor. The current color is displayed in image 

viewer, “2/4 images” and before-and-after views.

 In-Folder Navigation
View the number of files in the current folder and the position of the current 

picture in the file list. Use the  and  buttons to go from one picture to 

another.



59Viewing Pictures Side-by-Side

Viewing Pictures Side-by-Side
View pictures side-by-side or compare enhanced pictures with the same pictures 

pre-enhancement.

2 Images/4 Images
Compare pictures side-by-side. This can be used to compare pictures from a single 

burst or that are otherwise nearly identical and choose your favorite shot.

 A Comparing Pictures

You can compare pictures from the same folder. To compare pictures from 

different folders, put them in the same album (0 “Collecting Pictures in Albums”, 

page 21).

1. Select “2 images” ( ) or “4 images” ( ) in the top toolbar. The current picture 

will be displayed in the left or top left frame.
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2. Click one of the other frames. The selected frame will be highlighted in white.

3. Display the filmstrip and select a picture to display it in the frame selected in 

Step 2 (0 “Filmstrip View”, page 47).



61Viewing Pictures Side-by-Side

 A Linked Displays

To view all the pictures at the same zoom ratio, select the link icon ( ) at the top 

right corner of the current picture. Scrolling the current picture will also scroll the 

pictures in the remaining frames.

 A Image Adjustments

Image adjustments apply only to the current picture (the picture highlighted in 

white).
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Before and After
Select  to compare selected pictures with the same pictures pre-enhancement. 

Any changes to the current picture are reflected in the pane on the right 

(0 “Enhancing Pictures”, page 81).

 ❚ Updating the “Before” Display
Clicking the “update” ( ) button in the “before” pane updates the display to show 

the picture’s current state. You may find this useful before going on to make 

additional adjustments.
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 ❚ Restoring the “Before” Display
Clicking the “restore original” ( ) button in the left (“before”) pane restores the 

display to show the original, unenhanced picture. JPEG and TIFF pictures previously 

edited in other software are restored to their last saved state.
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Filters

0 Filter Options

0 Rating Pictures

0 Labeling Photos

0 Protecting Pictures

0 Advanced Filters
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Filter Options
There are a variety of marking options that can be used to filter pictures. The 

markings available are listed below.

 Ratings
Rate pictures (0 “Rating Pictures”, page 66).

 Labels
Label pictures. There are ten different labels to choose from (0 through 9, where 

0 is “no label”), each with a different color (0 “Labeling Photos”, page 70).

 Protection
Protect pictures from accidental deletion (0 “Protecting Pictures”, page 74).
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Rating Pictures
Assign pictures ratings of from zero to five stars or select d to mark pictures as 

candidates for later deletion. Ratings assigned on the camera are reflected in 

NX Studio.

Choosing a Rating
Ratings are displayed in a variety of locations.

 ❚ On Thumbnails
Mouse over the thumbnails and choose the desired number of stars. To cancel, click 

the same number of stars again.

 AAssigning the Same Rating to Multiple Pictures

Ratings chosen after selecting multiple pictures using the control (or in macOS, 

the command) or shift key apply to all images in the selection.
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 ❚ On the Bottom Toolbar
The current picture can be rated by clicking the desired number of stars in the 

toolbar at the bottom of the view area. To cancel, click the same number of stars 

again (0 “The Bottom Toolbar”, page 54).

 A Rating Pictures in the “2/4 Images” Views

Ratings apply only to the current picture (the picture highlighted in white).
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 ❚ In the [XMP/IPTC] Tab
Rate pictures by clicking the desired number of stars under [XMP/IPTC] > [Rating] 

in the Adjustments/Info palette. To cancel, click the current number of stars (0 “The 

Adjustments/Info Palette”, page 24).
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Filtering Pictures by Rating
Pictures can be filtered by rating. Click  and choose the desired rating or ratings.

A filter showing two- and four-star pictures

Filmstrip view
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Labeling Photos
Choose from nine different labels (1 through 9). Labels cannot be applied to videos.

Choosing a Label
Labels are displayed in a variety of locations.

 ❚ On Thumbnails
Mouse over thumbnails (if the picture is currently unlabeled, a “0” will be displayed) 

and click the desired labels.

 AAssigning the Same Label to Multiple Pictures

Labels chosen after selecting multiple pictures using the control (or in macOS, 

the command) or shift key apply to all images in the selection.
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 ❚ On the Bottom Toolbar
Click the desired label in the toolbar at the bottom of the view area (0 “The Bottom 

Toolbar”, page 54).

 A Labeling Pictures in the “2/4 Images” Views

Labels apply only to the current picture (the picture highlighted in white).
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 ❚ In the [XMP/IPTC] Tab
Click the desired label under [XMP/IPTC] > [Label] in the Adjustments/Info palette 

(0 “The Adjustments/Info Palette”, page 24).
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Filtering Pictures by Label
Pictures can be filtered by label. Click  and choose the desired label or labels.

A filter showing pictures labeled 1, 3, and 4

Filmstrip view
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Protecting Pictures
Protected pictures cannot be deleted or renamed. Pictures protected using the 

camera are protected in NX Studio.

Changing Picture Protection Status
Protection status is displayed in a variety of locations.

 ❚ On Thumbnails
Mouse over unprotected pictures and click the protect icon to enable protection ( ). 

Click again to disable protection ( ). In the thumbnail list, protection can be applied or 

removed in the [Name] field.

 A Protecting Multiple Pictures

Changes to protection made after selecting multiple pictures using the control 

(or in macOS, the command) or shift key apply to all images in the selection.
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 ❚ On the Bottom Toolbar
Enable ( ) or disable ( ) protection by clicking the protect icon in the toolbar at 

the bottom of the view area (0 “The Bottom Toolbar”, page 54).

 A Protecting Pictures in the “2/4 Images” Views

Changes to protection status apply only to the current picture (the picture 

highlighted in white).
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Filtering Pictures by Protection Status
Pictures can be filtered by protection status. Click  and then filter pictures by their 

protection status by clicking the two protection filter buttons to toggle the “protected” 

button on ( ) or off ( ) and the “unprotected” button on ( ) or off ( ). Select both 

options (or neither option) to view all pictures.

Viewing protected pictures only

Filmstrip view
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Advanced Filters
Click  to filter pictures by rating, label, protection status, shooting data, or other 

criteria.

 View/Hide
Click to view or hide the advanced filters palette (0 “The Advanced Filters 

Palette”, page 79).

 Rating
Filter pictures by rating (0 “Rating Pictures”, page 66).

 Label
Filter pictures by label (0 “Labeling Photos”, page 70).
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 Protection
Filter pictures by protection status (0 “Protecting Pictures”, page 74).

 File Type
Filter pictures by file type.

 Keyword Search
Filter pictures by file name or keywords in the XMP/IPTC metadata.
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The Advanced Filters Palette
To view the advanced filters palette, click  in the filter bar.

Only pictures that meet all the selected criteria will be displayed.
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Criteria can be selected by clicking the  icon in the filter bar.

Click [Clear All] to clear all criteria.
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Enhancing Pictures

0 The Adjustments Tab

0 The Picture Controls Tool

0 The White Balance Tool

0 The Exposure Compensation Tool

0 The Active D-Lighting Tool

0 The Adjust Brightness and Color Tool

0 The Levels and Tone Curves Tool

0 The LCH Tool

0 The Color Booster Tool

0 The Noise Reduction Tool

0 The Sharpness Adjustment Tool

0 The Retouch Brush

0 The Color Control Point Tool

0 Cropping Pictures

0 The Straighten Tool

0 The Perspective Control Tool

0 The Camera Corrections Tool

0 The Lens Corrections Tool

0 The Versions Tool

0 Copying Adjustments
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The Adjustments Tab
Enhance pictures using the tools in the adjustments/info palette [Adjustments] 

pane.

 Adjustments Manager
Copy adjustments from one picture to another or save current settings for 

later use. You can also cancel all changes and restore pictures to their original, 

unenhanced state (0 “Copying Adjustments”, page 152).

 “Apply” Check Box
A check appears in this box whenever you make adjustments. Remove the 

check to hide adjustments.

 Gray Point Sample Tool
Activate the gray point sample tool. Click anywhere in the picture to adjust 

white balance so that the sampled pixel takes on a neutral gray color (0 “The 

White Balance Tool”, page 96).

 Retouch Brush
Remove dust and scratches (0 “The Retouch Brush”, page 122).
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 Color Control Point Tool
Enhance pictures using color control points (0 “The Color Control Point Tool”, 

page 125).

 Crop
Crop pictures (0 “Cropping Pictures”, page 134).

 Straighten Tool
Straighten pictures (0 “The Straighten Tool”, page 139).

 Palette Options
Choose the items displayed in the adjustments palette.

 Adjustments Palette
Enhance pictures.
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The Adjustments Palette
The tools in the image adjustments palette are grouped into categories. Click the 

/  buttons to view or hide each tool.

 ❚ [Basic Edit Palettes]
This category consists chiefly of tools for working with RAW pictures, such as 

[Picture Control], [Exposure Comp.], and [White Balance].

• [Picture Control] (RAW pictures only): Adjust Picture Controls (0 “The Picture 

Controls Tool”, page 90).

• [White Balance] (RAW pictures only): Adjust white balance (0 “The White 

Balance Tool”, page 96).

• [Exposure Comp.] (RAW pictures only): Adjust exposure (0 “The Exposure 

Compensation Tool”, page 99).

• [Active D-Lighting] (RAW pictures only): Adjust Active D-Lighting (0 “The 

Active D-Lighting Tool”, page 100).

• [Adjust Brightness and Color]: Adjust overall brightness, contrast, and 

saturation or reveal details in highlights and shadows (0 “The Adjust Brightness 

and Color Tool”, page 101).

 ❚ [Levels & Curves]
Adjust contrast, tone curves (brightness), and color balance (0 “The Levels and 

Tone Curves Tool”, page 103).

 ❚ [Lightness, Chroma, and Hue Adjustment]
Adjust colors.

• [LCH]: Make adjustments to lightness, chroma, and hue channels (0 “The LCH 

Tool”, page 107).

• [Color Booster]: Optimize saturation to make colors more vivid (0 “The Color 

Booster Tool”, page 116).
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 ❚ [Adjust Details]
Reduce image noise and adjust sharpness.

• [Noise Reduction]: Reduce image noise (0 “The Noise Reduction Tool”, page 

117).

• [Sharpness Adjustment]: Increase sharpness by making outlines more distinct 

(0 “The Sharpness Adjustment Tool”, page 119).

 ❚ [Touch-up]
Target selected areas for dust removal or color enhancement.

• [Retouch Brush]: Remove dust and scratches (0 “The Retouch Brush”, page 

122).

• [Color Control Point]: Make targeted adjustments to color and brightness 

(0 “The Color Control Point Tool”, page 125).

 ❚ [Adjust Composition]
Crop and straighten pictures and correct for the effects of perspective.

• [Crop]: Crop pictures (0 “Cropping Pictures”, page 134).

• [Straighten]: Straighten pictures (0 “The Straighten Tool”, page 139).

• [Perspective Control]: Correct for the effects of perspective (0 “The Perspective 

Control Tool”, page 143).

 ❚ [Camera and Lens Corrections]
Correct for chromatic aberration and other artifacts originating with the camera or 

lens.

• [Camera Corrections]: Correct for moiré, dust on the image sensor, and red-eye 

(0 “The Camera Corrections Tool”, page 144).

• [Lens Corrections]: Correct for axial and lateral color aberration and other 

artifacts originating with the lens (0 “The Lens Corrections Tool”, page 146).



86 The Adjustments Tab

 ❚ [Versions]
Choose whether to apply changes made using Capture NX or Capture NX 2 

(0 “The Versions Tool”, page 150).

 AHiding Adjustments

With the exception of [Versions], edits are indicated by a check mark at each 

tool’s top right corner. Removing the check hides the changes.
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 A Reverting Adjustments

Each tool offers a pull-down menu that changes to [Current] when edits are 

made. Select [Original Value] to revert to the settings in effect when the picture 

was created.
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Customizing the Adjustments Palette
Choose the tools displayed in the adjustments palette to create custom workspaces. 

Custom workspaces can be recalled via the  menu.

1. Click  in the [Adjustments] tab and select [Customize Adjustments].

2. A dialog will be displayed, click [New] ( ) and name the workspace ( ).
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3. Select the tools that will be displayed in the adjustments palette. You can 

change the order of the tools using the  and  buttons. Click [OK] to save 

the new workspace when changes are complete.

4. To display only the tools selected in Step 3, click  in the [Adjustments] tab 

and choose the workspace from the list.
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The Picture Controls Tool
Adjust Picture Controls. Note that this tool is available with RAW pictures only.
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 Color Reproduction Process
Choose a color reproduction process. The choice of Picture Controls varies with 

the option selected. [Camera compatible] is the only option available for RAW 

pictures in NRW format or that were taken with a camera that supports the 

latest Picture Controls.

• [Latest Picture Control]: Colors are processed using the latest Picture 

Controls, including those identified as [Creative Picture Control]. Picture 

Controls and parameters added with recent cameras can be applied to RAW 

pictures taken with models that do not offer these options.

• [Camera compatible]: Colors are processed using the Picture Controls for 

the camera that took the picture. Choose this option for color reproduction 

matching that used on the camera.

 A Color Reproduction Process

The option selected by default in the case of pictures for which two color 

reproduction options are available can be chosen using [NEF (RAW) 
Processing] > [Color Reproduction Process] in the [Options] dialog 

(0 “[NEF (RAW) Processing]”, page 281).

 Picture Control
Choose a Picture Control for the pictures in the current selection.

 Picture Control Parameters
Adjust Picture Control parameters (0 “Picture Control Parameters”, page 92). 

Where available, parameters can be adjusted automatically by selecting [Auto]. 

Note that even in the case of pictures taken under similar conditions, the results 

may vary with exposure and the position and size of the subject in the frame.

 [Reset]
Reset all parameters to their default values.



92 The Picture Controls Tool

Picture Control Parameters
After choosing a color reproduction process, choose a Picture Control and adjust 

Picture Control parameters. The parameters available vary with the camera used and 

the color reproduction process and Picture Control selected.

 ❚ Recent Picture Controls
The parameters below are available when [Latest Picture Control] is chosen as the 

color reproduction process or if the picture was taken with a camera that supports 

only the most recent Picture Controls (i.e., pictures for which the only available color 

reproduction process is [Camera compatible]).

[Quick sharp]
Quickly adjust levels for balanced [Sharpening], [Mid-range sharpening], and 

[Clarity]. Select [Auto] to let the camera adjust sharpening automatically. The 

various sharpening parameters can also be adjusted manually.

• [Sharpening]: Control the sharpness of details and outlines.

• [Mid-range sharpening]: Adjust the sharpness of patterns and lines at levels 

of detail between those to which [Sharpening] and [Clarity] apply.

• [Clarity]: Adjust overall sharpness and the sharpness of thicker outlines 

without affecting brightness or dynamic range.

[Contrast]
Adjust contrast. Choose lower values for less contrast, higher values for more 

contrast. You will not be able to adjust this parameter if the current Picture 

Control uses a custom curve.

[Brightness]
Adjust brightness without losing detail in highlights and shadows. You will not 

be able to adjust this parameter if the current Picture Control uses a custom 

curve.
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[Saturation]
Control the vividness of colors. Choose lower values for more muted colors and 

higher values for more vivid colors.

[Hue]
Adjust hue.

[Filter Effect]
Simulate the effects of color filters on monochrome pictures.

[Toning]
Choose a base tint for results that mimic the effects of printing pictures on 

tinted paper.

[Adjust Saturation]
Choose the saturation of the tint selected for [Toning]. Saturation cannot be 

adjusted when [B&W] is selected for [Toning].

 A “Auto”

When the [Auto] Picture Control is selected, settings can be adjusted in the 

range [A−2] to [A+2].

 A Creative Picture Controls

An [Effect level] slider is displayed when a [Creative Picture Control] such 

as [Dream], [Morning], or [Pop] is selected. Use the slider to choose the effect 

level.
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 ❚ Earlier Picture Controls
If the color reproduction process menu offers a choice of color reproduction 

methods, the parameters listed below will be available when [Camera 
compatible] is selected.

[Quick Adjust]
Make across-the-board adjustments to Picture Control parameters. The effect 

of the selected Picture Control can be muted by dragging the slider left or 

heightened by dragging the slider right. [Quick Adjust] affects all Picture 

Control settings simultaneously and cancels any changes made separately to 

the individual parameters.

[Sharpening]
Control the sharpness of outlines. Choose higher values for more sharpening.

[Clarity]
Adjust clarity. This option is available only with pictures taken using cameras 

that support the [Clarity] parameter.

[Contrast]
Adjust contrast. Choose lower values for less contrast, higher values for more 

contrast.

[Brightness]
Adjust brightness without losing detail in highlights and shadows.

[Saturation]
Control the vividness of colors. Choose lower values for less saturation, higher 

values for more saturation.

[Hue]
Adjust hue.
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[Filter Effect]
Simulate the effects of color filters on monochrome pictures.

[Toning]
Choose a base tint for results that mimic the effects of printing pictures on 

tinted paper.

[Adjust Saturation]
Choose the saturation of the tint selected for [Toning]. Saturation cannot be 

adjusted when [B&W] is selected for [Toning].
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The White Balance Tool
Adjust white balance. Note that this tool is available with RAW pictures only.

 White Balance Menu
Choose a white balance setting.

 [Gray Point Sample Tool]
Click anywhere in the picture to adjust white balance so that the sampled pixel 

takes on a neutral gray color.

 [Color Temperature]
Choose a color temperature.

 [Tint]
Choose lower values for less green and more magenta, higher values for the 

opposite effect.
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The Gray Point Sample Tool
Using the gray point sample tool, you can click anywhere in the picture to adjust 

white balance so that the sampled pixel takes on a neutral (white or gray) color. 

Color casts can be eliminated with a single click.

1. Activate ( ) the gray point sample tool. You can also click the icon for the tool 

at the top of the adjustments palette.

2. Click a point in the picture that you think should be a neutral color. [Use Gray 
Point] will appear in the white balance menu and the colors in the picture will 

be adjusted. In this example, clicking what in the actual subject was a white 

wall eliminates the blue color cast. You can sample the picture multiple times 

while the gray point sample tool is active. You can also drag the cursor over the 

image to use the average color value for the selected area.
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3. When [Use Gray Point] appears in the white balance menu, [Color 
Temperature] changes to [Fine Adjustment] and white balance can be fine-

tuned using the slider.
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The Exposure Compensation Tool
Adjust overall exposure, making pictures lighter or darker. Note that this tool is 

available with RAW pictures only.

Exposure can be fine-tuned in the range +5 and −5 EV in increments of 0.01 EV.
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The Active D-Lighting Tool
Bring out details in highlights and shadows. Note that this tool is available with RAW 

pictures only.

The strength of the effect can be chosen from the pull-down menu.



101The Adjust Brightness and Color Tool

The Adjust Brightness and Color Tool
Adjust overall brightness and contrast, or make adjustments that affect highlights 

and shadows.

 [Brightness]
Adjust overall brightness. The higher the value, the brighter the result.

 [Contrast]
Adjust overall contrast. Choose lower values for less contrast, higher values for 

more contrast.

 [Saturation]
Adjust the vividness of colors throughout the picture. Choose lower values for 

more muted colors and higher values for more vivid colors.

 [Highlight Protection]
Preserve details in highlights. Choose higher values to reduce highlight 

brightness.
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 [Shadow Protection]
Preserve details in shadows. The higher the value, the brighter the result.

 [D-Lighting HS]
Brighten shadows in backlit or poorly-lit pictures or reduce loss of detail in 

highlights. Higher values reduce the contrast between shadows and highlights.
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The Levels and Tone Curves Tool
Adjust contrast, tone curves (brightness), and color balance. Adjustments can be 

made to specific portions of the tone range, enhancing pictures without sacrificing 

detail. This can be used to exploit the gamut and dynamic range of specific printers, 

monitors, or other devices to the full.

 Channel
Choose the channel to which changes will apply.

 Set Black Point
Click this button and then click the picture to sample the colors for the pixel 

under the cursor. The black point sliders for the [Red], [Green], and [Blue] 

channels will be set to the values for the selected pixel.
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 Set Neutral Point
Click this button and then click the picture to sample the colors for the pixel 

under the cursor. Gamma for the [Red], [Green], and [Blue] channels will be 

adjusted to equalize the RGB values for the selected pixel.

 Set White Point
Click this button and then click the picture to sample the colors for the pixel 

under the cursor. The white point sliders for the [Red], [Green], and [Blue] 

channels will be set to the selected pixel.

 Add Anchor Point
Click this button and then click the picture to add points to the curves for all 

channels corresponding to the values of the pixel under the cursor.

 Auto Contrast
Set white and black points automatically to adjust the distribution of colors for 

each channel.

 Reset Current Channel
Restore the default curve for the current channel.

 Reset All Channels
Restore the default curves for all channels.
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 White-Point Output-Level Slider
Choose the maximum output level for the current picture. Dragging the slider 

down lowers the brightness of the brightest pixels.

 Tone Curve
The slope and shape of the curve determines the brightness of the picture in 

the corresponding portion of the tone range. Anchor points added to the curve 

can be deleted by pressing the delete key or dragging them out of the palette.

 Histogram
View how the pixels in the picture are distributed with respect to brightness.

 Black-Point Output-Level Slider
Choose the minimum output level for the current picture. Dragging the slider 

up increases the brightness of the darkest pixels.
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 Black-Point Input Slider
Dragging the slider to the right sets the pixels in the portion of the tone range 

to its left to the minimum output level (black, or when a specific color channel is 

selected, no color); the remaining pixels are fitted to the new tone range.

 White-Point Input Slider
Dragging the slider to the left sets the pixels in the portion of the tone range to 

its right to the maximum output level (white, or when a specific color channel is 

selected, the maximum value for that channel); the remaining pixels are fitted to 

the new tone range.

 [Gamma]
Dragging the slider to the left increases the brightness of mid-tones, while 

dragging it to the right makes mid-tones darker.

 A Sampling the Current Channel

To apply the auto contrast, black point, white point, and add anchor point tools 

only to the current channel, click the tool while pressing the control (or in macOS, 

the option) key.
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The LCH Tool
Make adjustments to lightness, chroma, and hue channels. Choose a channel using 

the menu in the LCH tool. The options available vary with the channel selected.
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Chroma
Adjust color saturation (vividness). Increase or decrease color saturation over the 

entire picture or a portion of the color range, making colors more or less vivid.

 Add Anchor Point
Click this button and then click the picture to add a point to the chroma curve 

corresponding to the value of the pixel under the cursor.

 Reset Current Channel
Reset the chroma curve to linear.

 Reset All Channels
Reset the [Chroma], [Hue], [Color Lightness], and [Master Lightness] curves 

to linear.
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 Chroma Curve
Moving an anchor point on the curve upwards makes colors in the affected 

portion of the color range more vivid, while moving it downward makes the 

affected colors less vivid (grayer). Anchor points added to the curve can be 

deleted by pressing the delete key or dragging them out of the palette.

 Output Slider
Increase or decrease the saturation of all colors in the image. Overall saturation 

can be increased by moving the slider up or decreased by moving it down.

 [Width]
Adjust the width of the chroma curve. Move the slider right to increase the 

range of colors affected by changes to chroma, centered on the currently-

selected point. Move the slider left to decrease the range of colors affected.

 [Exclude Gray]
Select this option to adjust chroma without affecting grays. This allows chroma 

to be increased without introducing a cast to neutral colors.
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Hue
Adjust hue over the entire picture or a portion of the color range. One application 

might be to deepen the colors in a pale blue sky.

 Add Anchor Point
Click this button and then click the picture to add a point to the hue curve 

corresponding to the value of the pixel under the cursor.

 Reset Current Channel
Reset the hue curve to linear.

 Reset All Channels
Reset the [Chroma], [Hue], [Color Lightness], and [Master Lightness] curves 

to linear.
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 Scale
Click to change the vertical scale from 60 ° through 120 ° to 180 ° and back 

again. The degrees in this case refer to a 360 ° color wheel. Increasing the scale 

increases the range of hues visible in the display, while decreasing the scale 

increases precision.

 Hue Curve
Select an anchor point on the curve that corresponds to the desired input 

color and drag it up or down until it intersects with the desired output color. 

Anchor points added to the curve can be deleted by pressing the delete key or 

dragging them out of the palette.

 Output Slider
Drag the slider up or down to modify the hue of all colors in the picture. The 

range of hues available varies with the option selected for scale ( ): ±60° when 

60° is selected, ±120° when 120° is selected, or ±180° when 180° is selected.

 [Width]
Adjust the width of the hue curve. Move the slider right to increase the range 

of colors affected by changes to hue, centered on the currently-selected point. 

Move the slider left to decrease the range of colors affected.
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Color Lightness
Adjust the lightness of selected colors. This can be used, for example, to brighten 

the blue of a dark sky without affecting chroma or hue.

 Add Anchor Point
Click this button and then click the picture to add a point to the color lightness 

curve corresponding to the value of the pixel under the cursor.

 Reset Current Channel
Reset the color lightness curve to linear.

 Reset All Channels
Reset the [Chroma], [Hue], [Color Lightness], and [Master Lightness] curves 

to linear.
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 Color Lightness Curve
The vertical axis corresponds to lightness, the horizontal axis to color. Moving 

an anchor point on the curve upwards makes colors in the affected portion of 

the color range brighter, while moving it downward makes the affected colors 

darker. Anchor points added to the curve can be deleted by pressing the delete 

key or dragging them out of the palette.

 [Width]
Adjust the width of the color lightness curve. Move the slider right to increase 

the range of colors affected by changes to color lightness, centered on the 

currently-selected point. Move the slider left to decrease the range of colors 

affected.
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Master Lightness
Adjust overall lightness without affecting chroma or hue. Settings can be adjusted 

using sliders or by directly editing the lightness curve.

 Add Anchor Point
Click this button and then click the picture to add a point to the master 

lightness curve corresponding to the value of the pixel under the cursor.

 Auto Contrast
Increase contrast by setting the white and black points to exclude a set 

proportion of the brightest and darkest pixels in the image.

 Reset Current Channel
Reset the master lightness curve to linear.
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 Reset All Channels
Reset the [Chroma], [Hue], [Color Lightness], and [Master Lightness] curves 

to linear.

 White-Point Output-Level Slider
Choose the maximum output level (white point).

 Luminosity Curve
The slope and shape of the curve determines the lightness of the picture in the 

corresponding portion of the tone range. Anchor points added to the curve can 

be deleted by pressing the delete key or dragging them out of the palette.

 Histogram
View how the pixels in the picture are distributed with respect to lightness. The 

horizontal axis corresponds to lightness (in the range 0–255), the vertical axis to 

the number of pixels.

 Black-Point Output-Level Slider
Choose the minimum (black point) output level.

 Black-Point Input Slider
Choose the minimum (black point) input level.

 White-Point Input Slider
Choose the maximum (white point) input level.

 [Gamma]
Choose the midpoint (gamma value).
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The Color Booster Tool
Optimize saturation to make colors more vivid.

 Level
Choose higher values to increase saturation.

 Subject Type
Choose from [People] and [Nature].

• [People]: Boost colors without affecting skin tones.

• [Nature]: Boost colors throughout the spectrum, including skin tones.
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The Noise Reduction Tool
Process pictures to reduce the effects of image noise.

 [Noise Reduction]
Select this option to enable noise reduction. You can then choose an option for 

[Method] and a noise-reduction amount.
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 [Method]
The options available vary with the camera used to create the current picture.

• [Camera’s noise reduction] (RAW pictures only): This option is displayed 

only if no other options are available. Select the amount ( ) from the pull-

down menu.

• [Faster]/[Better Quality]/[Better Quality 2013] (RAW pictures only): 

Choose [Faster] for faster processing, [Better Quality] or [Better Quality 
2013] for higher-quality results.

 – [Intensity]: The higher the value, the smoother the results and the less 

visible the artifacts caused by image “noise”.

 – [Sharpness]: Choosing higher values for [Intensity] may smooth the 

image to the point that details are lost. This can be countered by increasing 

[Sharpness].

 A [Better Quality 2013]

This option excels in reducing color noise at short wavelengths and over 

evenly-colored areas of the image. Selecting [Better Quality 2013] displays 

additional [Luminance] and [Color] items, allowing intensity and sharpness 

to be adjusted separately for each of these parameters.

 Amount
Choose the amount of noise reduction performed when [Camera’s noise 
reduction] is the only option available in the [Method] menu.

 [Edge Noise Reduction] (RAW Pictures Only)
Select this option to make outlines more distinct by reducing the occurrence of 

noise artifacts around edges.

 [Astro Noise Reduction] (RAW Pictures Only)
Select this option to reduce the occurrence of randomly-spaced bright pixels in 

long exposures.

 D [Astro Noise Reduction]

This option cannot be applied to small RAW pictures taken with the D4S, 

D810, or D810A.
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The Sharpness Adjustment Tool
Increase sharpness by making edges more distinct. Use [Unsharp Mask] to 

increase the contrast of edges while leaving other areas untouched.

 [Sharpness]
Choose higher values to increase the sharpness of outlines throughout the 

picture.
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 [Unsharp Mask]
Select this option to sharpen pictures using unsharp mask.

 Delete
Delete the currently-selected mask from the unsharp mask list.

 Move Up/Move Down
Move the currently selected mask up or down in the unsharp mask list.

 Unsharp Mask List
A list of unsharp masks. Masks are identified by color channel, intensity, radius 

(edge width), and threshold (e.g., “Red, 50%, 10%, 0”). They apply in the order 

listed; to change the order, use the up/down buttons.
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 Color
Choose the color channel to which the unsharp mask applies.

 [Intensity]
Choose a sharpening amount. The higher the value, the more edge contrast will 

be increased.

 [Radius]
Edge width. The greater the radius, the wider the edges in the sharpened image 

will appear.

 [Threshold]
The limit at which sharpening will be applied. If the threshold is zero, sharpening 

will apply to all pixels in the image. Increasing the threshold increases the 

amount of contrast that must be present between pixels before the mask will 

be applied, with the result that only more distinctly contrasting edges will be 

affected.
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The Retouch Brush
Remove dust and scratches.

 [Auto Retouch Brush Tool]
Selecting ( ) this tool enables the retouch brush.

 [Brush Size]
Choose the brush size.

Using the Retouch Brush

1. Display one or more pictures in single- or multi-frame view. This option cannot 

be used with thumbnails.
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2. Activate ( ) the retouch brush. You can also click the icon for the tool at the 

top of the adjustments palette.

3. Choose the brush size.

 A Brush Size

A brush larger than the defect you are attempting to correct may affect 

neighboring areas of the picture.
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4. Keeping the mouse button pressed, drag the brush over the defect; the 

selected area will be shown by a translucent red line. Continue until the defect 

is completely covered.

5. Release the mouse button. The defect will be blended with the surrounding 

areas of the picture, removing it.

 A The Retouch Brush

The retouch brush copies data from surrounding areas of the picture 

automatically and pastes them over the defect.

• It may not produce the desired results if defects are widespread, the tool is 

dragged a long distance, or the affected area is very large.

• The time required to complete processing varies with the picture.
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The Color Control Point Tool
Selectively brighten, darken, or modify colors. NX Studio automatically detects the 

colors at a point of your choosing and applies adjustments only to similar colors in 

the surrounding area.

Color Control Points
When you place a color control point ( ), NX Studio automatically detects the 

color at the chosen point and selects all similar colors in the surrounding area. The 

effect is controlled by sliders: a single size slider ( ) used to choose the size of the 

area affected and multiple adjustment sliders ( ). These sliders are used to adjust 

colors and choose the area to which the adjustments apply.

• Changes are made by dragging the slider handles ( ).

• The default adjustment sliders are [B] (brightness), [C] (contrast), and [S] 

(saturation).
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 A Color Model

You can click the triangle at the bottom or top of the sliders to switch between 

the current color model ([BCS], [RGB], or [HSB]) and [All].
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Using Color Control Points

1. Display one or more pictures in single- or multi-frame view. Color control 

points cannot be used with thumbnails.

2. Activate ( ) the color control point tool. You can also click the icon for the tool 

at the top of the adjustments palette.
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3. Click the picture to add a color control point. Drag it to the area you want to 

modify.

4. Adjust the size of the control point by dragging the handle of the size slider 

left or right. The effect applies in a circle (shown by a dotted line) centered on 

the control point. It diminishes with the distance from the control point. The 

longer the slider, the greater the area affected.
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5. Drag the handles of the adjustment sliders left or right to adjust the selected 

color. The illustration shows the [B] (brightness) slider being used to adjust the 

brightness of the sky. The effect applies only to the blue of the sky, leaving the 

color of the building unaffected, and diminishes with the distance from the 

control point.

6. Multiple control points can be added to each picture. Repeat Steps 3 through 

5 to add color control points as needed.

 AAdding Control Points

The practical maximum for the number of control points that can be added to a 

single picture is about 100.

 A Copying Color Control Points

Selected control points can be copied using the [Copy] and [Paste] commands 

in the [Edit] menu.
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The Adjustments Palette Color Control Point 
Tool

 [Color Control Point Tool]
Select ( ) to enable the color control point tool.

 Color Control Points
Select from a list of existing color control points in the current picture.

• To hide the effects of a selected control point, remove the check from the 

adjacent box.

• To delete the point altogether, click the  button.
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 [Show affected area]
View the area affected by the selected control point, with the area in which the 

effects are most noticeable shown in white.

 [Do not apply to selected areas]
Disable the adjustment sliders for the selected control point. This also prevents 

changes to other control points affecting colors in the selected area. The size of 

the area protected can be adjusted using the size slider.

 Color Picker
Use a color picker to choose the target color for the selected control point. 

Objects affected by the control point will be converted to the selected color.
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 Color Model
Choose a color model for the selected control point. This determines the 

adjustment sliders displayed on the control point and in the color control point 

tool.

• [All]: Display sliders for [Hue] ([H]), [Saturation] ([S]), [Brightness] ([B]), 

[Contrast] ([C]), [Red] ([R]), [Green] ([G]), [Blue] ([B]), and [Warmth] ([W]).

• [BCS]: Display sliders for [Brightness] ([B]), [Contrast] ([C]), and [Saturation] 

([S]).

• [HSB]: Display sliders for [Hue] ([H]), [Saturation] ([S]), and [Brightness] 

([B]).

• [RGB]: Display sliders for [Red] ([R]), [Green] ([G]), and [Blue] ([B]).
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 [Size]
Adjust the size of the selected control point.

 Adjustment Sliders
Use the sliders to make adjustments to colors in the area affected by the 

selected control point. The sliders displayed vary with the color model selected.

 [Reset]
Reset values for the selected control point to those in effect before any changes 

were made.
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Cropping Pictures
Crop unwanted elements from pictures.

 [Crop Tool]
Selecting ( ) this tool enables cropping.

 Aspect Ratio
Choose the crop aspect ratio. To select a crop with no fixed aspect ratio, choose 

[Free Crop].

 Rotate Crop
Rotate the crop 90°.

 Crop Dimensions
The dimensions of the current crop. To enter the dimensions directly in the text 

boxes, select [Custom] in the aspect-ratio pull-down menu.

 [Cancel]
Cancel the current crop.

 [Proceed]
Apply the current crop.

 [Show Cropping Grid]
Display an evenly-spaced 3 × 3 grid inside the crop.
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Using the Crop Tool

1. Display one or more pictures in single- or multi-frame view. This option cannot 

be used with thumbnails.

2. Activate ( ) the crop tool. You can also click the icon for the tool at the top of 

the adjustments palette.
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3. Choose an aspect ratio.

 AAspect Ratio

The aspect ratio can be changed after you have resized and positioned the 

crop.

4. Drag the cursor over the picture to select the crop. The area outside the crop is 

shown in gray.
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5. Resize the crop by dragging the corners. You can also place the cursor in the 

crop and drag the entire crop to a new location.

6. Double-click inside the crop or click the [Proceed] button in the adjustments 

palette to crop the picture.
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 A Resetting the Crop

When the picture is cropped, [Proceed] changes to [Reset]. Click [Reset] to reset 

the crop.
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The Straighten Tool
Straighten pictures by up to ±10°.

 [Straighten Tool]
Select ( ) the straighten tool to straighten pictures by dragging.

 Straighten
Straighten pictures by from −10 to +10 degrees. Choose lower values to rotate 

pictures to the left, higher values to rotate them to the right.

 [Include Areas with No Image Data]
Select this option to fill empty corners with black.
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Straightening Pictures
Pictures can be straightened by dragging the cursor parallel to lines you want to be 

horizontal or vertical.

1. Display one or more pictures in single- or multi-frame view. This option cannot 

be used with thumbnails.

2. Activate ( ) the straighten tool. You can also click the icon for the tool at the 

top of the adjustments palette.
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3. Drag the cursor parallel to a reference line in the picture. In this example, the 

window frame serves as a reference line.

4. The picture will be rotated by up to ±10 ° to make the reference line horizontal 

or vertical. The degree of rotation will be displayed in the text box in the 

adjustments palette.
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 ❚ Include Areas with No Image Data
Straightening pictures adds areas that contain no image data. At default settings, 

pictures will automatically be cropped to remove empty corners. Selecting [Include 
Areas with No Image Data] instead fills the empty corners with black.

“Include Areas with No Image Data” 

disabled

“Include Areas with No Image Data” 

enabled
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The Perspective Control Tool
Adjust perspective horizontally or vertically by amounts of from −20 to +20.

 [Vertical]
Choose lower values to stretch pictures at the bottom, higher values to stretch 

them at the top.

0−20 20

 [Horizontal]
Choose lower values to stretch pictures at the left edge, higher values to stretch 

them at the right.

0−20 20
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The Camera Corrections Tool
Correct for moiré, dust on the image sensor, and red-eye.

 [Color Moiré Reduction] (RAW Pictures Only)
Reduce color moiré (an image artifact visible where regular patterns overlap). 

The amount of reduction can be selected from the pull-down menu.

 [Image Dust Off] (RAW Pictures Only)
Image Dust Off reference data (NDF files, extension “.ndf”) recorded using the 

camera can be used to determine the location of dust in front of the image 

sensor. Selecting this option allows pictures to be compared with these data to 

mitigate the dust’s effects.

• If no reference data are currently selected when you enable this option, you 

will be prompted to choose an NDF file.

• If the current folder contains an Image Dust Off reference file, a message will 

be displayed asking if you want to use the file for Image Dust Off. If you select 

[No] or if the current folder does not contain an Image Dust Off reference file, 

you will be prompted to choose the file manually.

• To switch to a different NDF file, click [Change] and choose a file.
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 [Auto Red-Eye]
Automatically detect and remove “red-eye”.

 A Image Dust Off

• The position and amount of dust in front of the image sensor changes from 

day to day. If possible, use reference data recorded in the last 24 hours.

• If the camera offers an [Clean image sensor] option, [Image Dust Off] will 

not be able to correctly apply data recorded before cleaning to pictures shot 

at a later date, as the position of the dust will have changed. If you plan on 

combining Image Dust Off with image sensor cleaning, we recommend that 

you not take pictures for use with Image Dust Off until you have recorded new 

reference data using [Clean sensor and then start] in the camera menus.

• This feature is not available with RAW pictures shot with [Medium] or [Small] 
selected for image size.

• For more information on Image Dust Off, see the camera manual.
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The Lens Corrections Tool
Correct for axial and lateral color aberration and other artifacts originating with the 

lens.

 [Lateral Color Aberration]
Reduce lateral color aberration (colored fringes and halos). In the case of RAW 

pictures, this option is selected automatically.
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 [Axial Color Aberration]
Reduce blurred colors caused by axial color aberration. The higher the value, the 

greater the effect.

 [Auto Distortion Control]
Select this option to use the lens information recorded with photographs to 

reduce the barrel distortion associated with wide-angle lenses and the pin-

cushion distortion associated with telephoto lenses.

• Auto distortion control can be enabled by selecting [On] in the pull-down 

menu.

• If the photograph was taken with using a waterproof lens, you will also be 

offered an [Auto (Underwater)] option. This last-named option can be used 

for reducing pin-cushion distortion in photos taken underwater.

 [Vignette Control]
Adjust for variations in peripheral illumination that occur with some lenses. The 

higher the value, the brighter the result.

 [Diffraction Compensation] (RAW Pictures/Compatible Cameras Only)
Reduce diffraction in pictures taken at small apertures (high f/-numbers).

 [PF Flare Control] (Compatible Lenses Only)
Bright light sources in the frame may give rise to ring flare, circular flare, or other 

flare effects. Select this option to reduce flare.

• Depending on the type and shape of the light source, the desired effects may 

not be achieved.

• Undesired results can be corrected by deselecting this option.

 [Fisheye] (Compatible Lenses Only)
Process photos taken with fisheye lenses so that they appear to have been 

taken with a wide-angle rectilinear lens (0 “Fisheye”, page 148).

This option is available only with photos taken using AF DX Fisheye-Nikkor 

10.5mm f/2.8G ED, AF Fisheye-Nikkor 16mm f/2.8D, or AF-S Fisheye NIKKOR 

8–15mm f/3.5–4.5E ED lenses. It cannot be used with other lenses.
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 [Lens]
The lens name provided in the lens data recorded with the picture, if any.

 [Include Areas with No Image Data]
Fill empty areas with a solid color.

 [Fill Color]
The color used to fill empty areas when [Include Areas with No Image Data] 

is selected.

Fisheye
Select [Fisheye] to process photos taken with fisheye lenses so that they appear to 

have been taken with a wide-angle rectilinear lens.

• Pictures taken with full-frame fisheye lenses will be cropped to match the camera 

picture angle, leaving an area centered around a line drawn vertically through the 

center of the image.

“Fisheye” disabled “Fisheye” enabled

• Pictures taken with circular fisheye lenses will also be cropped to match the 

camera picture angle, but in this case what remains is the area at the center of 

the image.

“Fisheye” disabled “Fisheye” enabled
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 ❚ Include Areas with No Image Data
Fisheye correction stretches pictures to create bends containing no image data. At 

default settings, pictures will automatically be cropped to remove empty portions. 

If [Include Areas with No Image Data] is selected, the image will not be cropped; 

instead, the empty portions will be filled with a solid color.

“Include Areas with No Image Data” 

disabled

“Include Areas with No Image Data” 

enabled

The color can be selected from the [Fill Color] menu.

“Fill Color”: Red
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The Versions Tool
Changes made in the Capture NX [Enhancement Steps] or Capture NX 2 [Adjust] 

section can be applied to pictures in NX Studio by selecting [Apply adjustment 
steps].

• Note that this applies only to RAW (NEF) pictures edited in Capture NX or Capture 

NX 2.

• For example, changes made in Capture NX 2 using the [Gaussian Blur] and 

[Photo Effects] tools will not be displayed when the pictures are opened 

in NX Studio if [Apply adjustment steps] is not selected. Selecting [Apply 
adjustment steps] applies both the [Gaussian Blur] and [Photo Effects] tools, 

rendering their effects visible. The effects cannot be adjusted, nor can they be 

viewed or hidden separately.

“Apply adjustment steps” disabled “Apply adjustment steps” enabled

• Some edits, including changes to [Picture Control] and [White Balance], are 

preserved when pictures are opened in NX Studio. In these cases, NX Studio can 

be used to make further modifications.
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 A Capture NX/Capture NX 2

• NX Studio cannot be used to edit pictures converted from JPEG or TIFF to NEF 

in Capture NX or Capture NX 2.

• NX Studio cannot be used to edit pictures modified using Color Efex Pro in 

Capture NX or Capture NX 2.
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Copying Adjustments
In NX Studio, you can apply any given set of adjustments to multiple pictures. 

Adjustments can be saved and recalled for application to other pictures via either 

the adjustments manager or an adjustments menu in each tool.

Tool Adjustments Menus
Current settings can be added to menus in each tool. The settings can then be 

selected from the menu and applied to other pictures. The text that follows uses the 

[Color Booster] tool for illustrative purposes.

1. Select a tool and adjust settings in the adjustments palette. Here we have 

selected [Nature] and set the slider to +30.

2. Select [Record Adjustments] from the pull-down menu.
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3. In the [Record Adjustments] dialog, enter a name for the new setting. In this 

example, we have named the setting “Nature +30”. After entering the name, 

click [OK].

4. The new settings are added to the pull-down menu and can now be applied 

to other pictures.

 A The Adjustments Menu

• Some tools may offer preset adjustments.

• Settings for some tools, such as [Retouch Brush], cannot be saved.

• Selecting [Edit Recorded Adjustments] from the pull-down menu displays a 

dialog where you can rename or delete previously-saved settings.
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The Adjustments Manager
The adjustments manager tool in the adjustments tab can be used to copy 

adjustments from one picture to another. Multiple adjustments can be applied 

simultaneously.

[Original Value]
Revert all changes and restore pictures to their original state.

[Last Saved State]
Restore pictures to a previous state. The state to which pictures are restored 

varies with the option selected in the [Save] category of the [Options] dialog 

(0 “[Save]”, page 284).

• If [Save adjustments to an adjustments (sidecar) file] is selected, the 

sidecar files for the selected pictures will be deleted and any adjustments or 

metadata saved to the sidecar files will be discarded.

• If [Save adjustments to the original image file] is selected, the pictures 

will be restored to the state in which they were last saved in NX Studio.
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[Copy All Adjustments]
Copy all adjustments.

[Paste Adjustments]
Apply adjustments copied using [Copy All Adjustments].

[Save All Adjustments]
Save the current settings for all adjustments in an adjustments file.

[Load Adjustments]
Load adjustments from an adjustments file and apply them to the pictures in 

the current selection.

[Record All Adjustments]
All current adjustments are saved and added as an option to the [Adjustments] 

pull-down menu.

[Edit Recorded Adjustments]
Reorder, rename, or delete adjustments previously added to the adjustments 

manager pull-down menu.

 A Copying Adjustments from RAW to JPEG or TIFF Images

When adjustments are copied from RAW to JPEG or TIFF images, [Exposure 
Comp.], [Picture Control], and other settings that are available only with RAW 

images will not be applied.
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 ❚ Copying Adjustments to Other Pictures
Copy adjustments from one picture to another or save current settings for later use.

1. Adjust settings in the adjustments palette. Here we have set [White Balance] 

to [Direct Sunlight] and [Exposure Comp.] to [−1 EV].
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2. Select [Copy All Adjustments] in the adjustments manager.

3. Select pictures. In this example, the selected picture has already been adjusted 

using the [Exposure Comp.] and [Active D-Lighting] tools.
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4. Select [Paste Adjustments] in the adjustments manager.
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5. The adjustments are applied to the selected pictures. [Exposure Comp.] 
changes to the value selected in Step 1 while [Active D-Lighting] reverts to 

[Original Value (Off)].



160 Copying Adjustments

 ❚ Adjustment Files
Adjustments can be saved to files using [Save All Adjustments]. The files can 

subsequently be loaded and applied to the pictures in the current selection using 

[Load Adjustments]. They can also be copied for use on other computers.

 ❚ Adding Adjustments
Selecting [Record All Adjustments] displays a [Record Adjustments] dialog 

where adjustments can be added to the adjustments manager pull-down menu.
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Video Editing (Movie Editor)

0 Editing Videos

0 Removing Unwanted Footage

0 Splicing Footage

0 Combining Photos and Videos

0 Menu Items in the [Edit Video] Window
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Editing Videos
After clicking [Edit Video] in the toolbar to launch Movie Editor video editing 

software, choose a task from the action list.

Removing Unwanted Footage
To trim unwanted segments and create a new video containing only footage you 

want to keep, select [Trim Video]. The footage can be selected using NX Studio 

(0 “Removing Unwanted Footage”, page 164).
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Splicing Footage
Select [Combine Videos] to splice two or more clips shot at the same settings into 

a single video (0 “Splicing Footage”, page 167).

Combining Photos and Videos
To create a slide show from photos and videos shot with the camera and save the 

resulting footage as a new video, select [Edit Video]. You can choose the transitions 

between slides and add titles and other text. You can also choose the background 

track (0 “Combining Photos and Videos”, page 169).
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Removing Unwanted Footage
Trim unwanted footage from videos shot with the camera and save what remains in 

new files.

1. Display a video in single-frame view. Mouse over the bottom of the viewer to 

display video playback controls.

2. Click the frame-by-frame display ( ) video playback control to view the frames 

in the video as thumbnails.
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3. Drag the handles at either end of the thumbnail display to select the clip you 

want to keep.

4. Click [Edit Video] in the toolbar and choose [Trim Video] from the action list.
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5. An [Output Video] dialog will be displayed; choose an option in the 

[Settings] menu.

 A The [Settings] Menu

• Select [Quick] to save the selected clip using the settings in effect when 

the original video was recorded. This requires less processing time, as the 

clip does not have to be re-encoded.

• For access to additional options, click [Advanced Settings] 

(0 “[Advanced Settings]”, page 191).

6. After choosing a destination and filename, click [Output] to save the clip as a 

new file.
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Splicing Footage
Make new videos by splicing clips together.

1. Select the clips in NX Studio.

 A Choosing Clips

• The clips must have been recorded with the same camera at the same 

settings.

• Videos can be spliced together from up to 20 clips.

• Clips cannot be spliced to footage created using Movie Editor.



168 Splicing Footage

2. Click [Edit Video] in the toolbar and choose [Combine Videos] from the 

action list.

3. An [Output Video] dialog will be displayed; choose a destination and 

filename and then click [Output] to splice the clips together and save the 

result as a new file. [Quick] is selected for [Settings] automatically; other 

options are not available.
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Combining Photos and Videos
Create new videos combining video and photos shot with your camera.

Basic Steps
The basic steps involved in creating videos are described below.

 A Supported File Types

Videos can include photos and video recorded with Nikon digital cameras in the 

following formats:

• Photos: JPEG, TIFF, and RAW (NEF/NRW)

• Video: MOV, AVI, and MP4 (H.264/AAC)

1. Click [Edit Video] in the toolbar after selecting files for the video in filmstrip or 

thumbnail view. Videos can include up to 200 photos and 20 video clips.
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2. Select [Edit Video] from the action list when prompted.

3. The [Edit Video] window will be displayed with the photos and videos you 

selected in Step 1 shown in the [Storyboard] tab (0 “The [Storyboard] Tab”, 

page 175). The items will be spliced together in the order listed, starting from 

the top left corner. Arrange the items in the desired order using drag and drop. 

Choose the transitions between items in the [Style] menu (0 “Transitions”, 

page 178).
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4. Preview the video in the preview area. To mute background music or the audio 

recorded with the original video clips, click the  toggle off ( ).
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5. Click [Create Video] to display the [Output Video] dialog. After choosing the 

file type, frame size, and destination and adjusting other settings as desired, 

click [Output] to save the video (0 “Exporting the Current Work”, page 190).

If desired, you can insert opening and closing titles or add captions to photos and 

video clips (0 “Adding Text”, page 180). You can also add background music 

(0 “Background Tracks”, page 188).
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 A Saving/Recalling Works in Progress

If you close the [Edit Video] window while editing is in progress, a confirmation 

dialog will be displayed prompting you to save your work to date. Work can be 

resumed by selecting [Load Saved Settings] in the [File] menu.

• You can save up to 10 works in progress. Once this limit is exceeded, an 

existing work will be deleted with each new work added, starting from the 

oldest work. To protect an existing work from deletion, click the  toggle on 

( ). Up to five works can be protected at a time.

• To resume a work in progress and display it in the storyboard, highlight it and 

click [Restore].

• If you select [Load Saved Settings] while working on another video, you will 

be prompted to save the current work.
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The “Edit Video” Window
The elements of the “Edit Video” window are shown below.

 Menu Bar
Select menu options (0 “Menu Items in the [Edit Video] Window”, page 193).

 Settings Area
The settings area features two tabs: a [Storyboard] tab where you can choose 

the transitions between slides and add, order, delete, and edit photos and video 

clips (0 “The [Storyboard] Tab”, page 175), and a [Decoration/Duration 
Settings] tab where you can select background music, add effects, and choose 

how long elements are displayed (0 “The [Decoration/Duration Settings] Tab”, 

page 177).

 Preview Area
Preview the current work.

 [Create Video]
View the [Output Video] dialog, where you can save your work as a new video 

(0 “Exporting the Current Work”, page 190).
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 ❚ The [Storyboard] Tab

 [Style]
Choose the transitions between items.

 Storyboard
Choose the order in which photos and video clips will appear, add titles, and 

perform other editing tasks.

• Items can be arranged in the desired order using drag and drop.

• Items can also be dragged into the storyboard from Windows Explorer or the 

Finder.

• Highlighted items can be deleted by pressing the delete key.

 [Add Videos and Images]
Add photos and video clips to the current work. Click this button and then click 

[OK] to return to NX Studio when prompted. Select pictures in NX Studio and 

click [Edit Video] to add the items at the end of the storyboard in the [Edit 
Video] window.
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 [Insert Opening Clip]
A [Text Settings] dialog will be displayed where you can enter opening titles 

for the current work (0 “The [Text Settings] Dialog”, page 183).

 [Insert Message Clip]
A [Text Settings] dialog will be displayed where you can enter an intertitle to 

be inserted before the item currently selected in the storyboard (0 “The [Text 

Settings] Dialog”, page 183).

 [Insert Ending Clip]
A [Text Settings] dialog will be displayed where you can enter closing titles for 

the current work (0 “The [Text Settings] Dialog”, page 183).
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 ❚ The [Decoration/Duration Settings] Tab

 [Background music (wav, m4a)]
A list of the tracks that can be added as background music to the current work 

(0 “Background Tracks”, page 188).

 [Effect]
Select [Give motion effect to still images] to add slow zoom and pan effects 

to photos.

 [Duration]
Choose how long photos are displayed.

• [Normal playback]: Choose an option for [Still image duration] from 

[Short], [Standard], and [Long] (display photos for about 3, 5, or 10 seconds 

respectively).

• [Summarize to fit to music]: This option is available when background 

music is enabled. It adjusts the display time for each photo so that the total 

matches the length of the background track. It cannot be selected if it would 

result in each photo being displayed for less than 2 seconds or for 15 seconds 

or more. For example, a minute-long background track requires at least 5, and 

no more than 30, photos.
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Transitions
Use the [Style] menu in the storyboard tab to choose the transitions between 

items. The effect can be previewed in the preview area.

[Standard]
Choose for smooth transitions between items with no fade in or fade out.

[Fade In/Fade Out]
Choose for a fade transition between items.

[Wipe]
Each new item slides in from the right.

[Random]
The transition between each item is selected randomly.

[Stop motion]
Photos are displayed in quick succession with an abrupt, flip-book style 

transition between each image. The length of time each photo is displayed can 

be selected in the [Still image duration] menu, where you can choose from 

[0.1 sec], [0.2 sec], and [0.5 sec].
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 D [Stop motion]

• If [Normal playback] is selected for [Duration] in the [Decoration/Duration 
Settings] tab, you will be able to choose the number of times the footage is 

repeated.

• If [Summarize to fit to music] is selected for [Duration] in the [Decoration/
Duration Settings] tab, the footage will be repeated as necessary to 

match the length of the background track and [Repeat count] will be set 

automatically. Footage cannot however be matched to the length of the 

background track if this would result in a value for [Repeat count] of 31 or 

more.

• In some operating environments, transitions may not display correctly when 

[0.1 sec] or [0.2 sec] is selected for [Still image duration]. This can be 

addressed by reducing the size of the preview area.
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Adding Text
You can add text to the current work. You can add opening and closing titles that 

are displayed for about 5 seconds each or add subtitles or other captions to photos 

and video clips.

 ❚ Opening and Closing Titles
Selecting [Insert Opening Clip] or [Insert Ending Clip] in the [Storyboard] tab 

displays a [Text Settings] dialog where you can enter opening or closing titles. 

Clicking [OK] adds the text as a five-second clip to the beginning or end of the 

current work (0 “The [Text Settings] Dialog”, page 183).
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 ❚ Intertitles
Selecting [Insert Message Clip] in the [Storyboard] tab displays a [Text 
Settings] dialog where you can enter an intertitle. Clicking [OK] adds the text as a 

five-second clip before the item currently selected in the storyboard (0 “The [Text 

Settings] Dialog”, page 183).
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 ❚ Captions
You can add captions to photos and videos. Click  to display the [Text Settings] 

dialog, where you can add a caption to the currently-selected item (0 “The [Text 

Settings] Dialog”, page 183).
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 ❚ The [Text Settings] Dialog
Settings for titles and captions can be adjusted in the [Text Settings] dialog.

 Text Box
Insert titles and captions here.

 [Where to Show]
Position the text in the frame.

 [When to Show]
Choose when the text is displayed.

• If you select [Throughout the Video], captions will be displayed for the 

duration of the clip (or, in the case of photos, as long as the photo is on the 

screen).

• Select [From the Beginning for] or [From the End for] to display captions 

for up to 3, 5, or 7 seconds after the item begins or before it ends.

• The only option available for titles is [Throughout the Video]. Titles are 

displayed for about 5 seconds.

 [Select Font]
To choose the font, font size, and font color, select this option and click 

[Change].
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 [Background Color]
This option is available for title clips only. Click [Palette] and choose a 

background color.

 Preview
Preview titles and captions here.

 [OK]
Add titles or captions to the storyboard. Captions are displayed superimposed 

on the selected item.

 ❚ Editing Existing Text
Titles and items with captions are indicated by  icons. The text can be displayed 

by mousing over the title segment or item. Clicking  displays the [Text Settings] 

dialog, where you can edit the text for the item in question.
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Trimming Clips
You can trim clips for inclusion in a longer work. Only the selected portions will be 

included in the final video.

 ❚ Choosing a Clip
Video clips in the storyboard are marked with a  icon. Mouse over a clip and click 

 to display the [Duration Settings] dialog.
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 ❚ The [Duration Settings] Dialog

 Preview Area
View the clip and confirm the start and end points.

 Time-line
The clip is divided into seven sections with thumbnails showing its overall flow. 

Drag the handles ( ) at either end to choose the start and end points.

 [IN]
Click this button during playback and use the playback slider ( ) to choose the 

start point.

 Playback Controls
Start, pause, or resume playback or rewind or advance the clip a frame at a time.

 [OUT]
Click this button during playback and use the playback slider ( ) to choose the 

end point.

 Start/End Point Counters
The playback position (in minutes and seconds) of the new start and end points.
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 ❚ Trimming the Clip
The start and end points for the portion of the clip that will be used in the final work 

can be chosen in the [Duration Settings] dialog. Drag the handles at either end of 

the time-line to choose the start and end points. Click [OK] once the desired start 

and end points are selected.

• The position of the frame displayed in the preview area is shown by the playback 

slider ( ).

• The time stamp for the current frame is shown below the bottom right corner of 

the preview area, together with the total clip length.

• Click the playback button ( ) to preview the selected portion of the clip.

• Use the frame advance ( ) and rewind ( ) controls to advance and rewind a 

frame at a time. Click the [IN] or [OUT] button to reset the start or end point to 

the current frame.

• To undo the operation after selecting start and end points, position the start and 

end point handles at the beginning and end of the clip and click [OK].
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Background Tracks
You can add background tracks in the [Decoration/Duration Settings] tab 

(0 “The [Decoration/Duration Settings] Tab”, page 177).

• Click the toggles in the track list to toggle tracks off ( ) and on ( ).

• The list includes three default sample files.

• Each work can include multiple background tracks. Total playback length is 

shown below the bottom right corner of the list.

• The current background track will fade out at the end of the video. If the selected 

background tracks are shorter than the video, they will repeat until the video 

ends.

• You can drag tracks to new positions in the track list. Tracks play in the order 

listed.

• To add tracks (up to a maximum of ten), click [Add]. Choose from WAV and AAC 

audio files. WAV files with bit depths greater than 16 bits are not supported.

• To remove a file from the track list, right-click (or in macOS, control-click) the file 

and select [Delete]. The default sample files cannot be removed from the list.
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 A Background Tracks

Background tracks are mixed with the original audio. You can suppress the 

original audio so that only the background tracks are audible by selecting 

[Clip] > [Set Volume of All Videos to 0]. To restore original audio to its recorded 

levels, select [Revert Video Volume to Default].
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Exporting the Current Work
Clicking [Create Video] displays the [Output Video] dialog. After choosing the 

file type, frame size, and destination and adjusting other settings as desired, click 

[Output] to save the video. 

 [Settings]
Adjust settings according to the video’s intended destination. If an option other 

than [Advanced Settings] is selected, the file format, frame size, and frame rate 

will be chosen automatically.

• [PC]: Select for high-quality video. Videos recorded using this option can be 

up to 60 minutes long.

• [YouTube]: Create compact files for upload to YouTube. Videos recorded 

using this option can be up to 15 minutes long and no more than 2 GB in 

size.

• [Web Service]: Keep file size to a minimum for upload to the Web. Videos 

recorded using this option can be up to 15 minutes long and no more than 

1 GB in size.

• [Advanced Settings]: Adjust settings individually. Videos recorded using this 

option can be up to 60 minutes long (0 “[Advanced Settings]”, page 191).

 [Save to]
The destination folder. To choose a different folder, click [Browse].

 [File name]
Enter a file name for the video.
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 ❚ [Advanced Settings]
Selecting [Advanced Settings] for [Settings] in the [Output Video] dialog lets 

you choose the file type, frame size, and frame rate.

[Format]
Choose a file type. All formats use H.264 compression.

• [MP4 (H.264/AAC)]: Save the video in MP4 format (extension “.mp4”) with 

audio recorded using AAC.

• [MOV (H.264/AAC)]: Save the video in MOV format (extension “.mov”) with 

audio recorded using AAC. Choose this option for smaller file sizes.

• [MOV (H.264/Linear PCM)]: Save the video in MOV format (extension 

“.mov”) with audio recorded using linear PCM.

[Size]
Choose a frame size.

[Frame rate]
Choose a frame rate.
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 A Frame Rate

The actual frame rates for the listed options are as follows:

• [60 fps]: 59.94 fps

• [50 fps]: 50 fps

• [30 fps]: 29.97 fps

• [25 fps]: 25 fps

• [24 fps]: 23.976 fps
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Menu Items in the [Edit Video] Window
The [Edit Video] window offers the following menus.

The [File] Menu

[Load Saved Settings]
Resume works in progress (0 “Saving/Recalling Works in Progress”, page 173).

[Add Videos and Images]
Add photos and videos to the storyboard.

[Create Video]
Save the current work as a new video (0 “Exporting the Current Work”, page 

190).

[Exit] (Windows Only)
Close the [Edit Video] window. You will be prompted to save any unsaved 

changes (0 “Saving/Recalling Works in Progress”, page 173).
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The [Movie Editor] Menu (macOS Only)

[About Movie Editor]
View version information.

[Quit Movie Editor]
Close the [Edit Video] window.

The [Edit] Menu

[Undo]/[Redo](macOS Only)
Undo or redo text editing.

[Copy]
Copy to the clipboard the photos or video or title clips currently selected in the 

storyboard.

[Paste]
Paste to the storyboard photos or video or title clips previously copied to the 

clipboard.

[Delete]
Delete the photos or video or title clips currently selected in the storyboard.
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The [Clip] Menu

[Trim]
When a video clip is selected in the storyboard, you can select this option to 

view the [Duration Settings] dialog (0 “The [Duration Settings] Dialog”, page 

186).

[Add or Update Text]
When a photo or video clip is selected in the storyboard, you can select this 

option to view the [Text Settings] dialog (0 “Adding Text”, page 180).

[Insert Opening Clip]
Add opening titles to the current work. Once opening titles are added, the 

name of this option will change to [Edit Opening Clip] (0 “Opening and 

Closing Titles”, page 180).

[Insert Message Clip]
Add intertitles to the current work. The intertitles are inserted before the item 

currently selected in the storyboard (0 “Intertitles”, page 181).

[Insert Ending Clip]
Add closing titles to the current work. Once closing titles are added, the name of 

this option will change to [Edit Ending Clip] (0 “Opening and Closing Titles”, 

page 180).
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[Set Volume of All Videos to 0]/[Revert Video Volume to Default]
Lower the volume of the original audio for all video clips in the storyboard to 

zero so that only background tracks can be heard. This option also applies to 

any clips added while it is selected. To restore the original audio, select [Revert 
Video Volume to Default].

[Sort Videos and Images by Date Shot]
Arrange the photos and videos in the storyboard in ascending order by date of 

recording.

The [Play] Menu

[Play]
Preview the current work. The name of this item changes to [Pause] while 

playback is in progress.

[Stop]
End preview.

The [View] Menu

[Storyboard]/[Decoration/Duration Settings]
Display the corresponding tab.
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The [Help] Menu

[Movie Editor Help]
View help.
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Location Data

0 What Location Data Can Do for You

0 The Map Toolbar

0 Viewing Shooting Locations

0 Editing Location Data

0 Adding Headings

0 Viewing Track Logs

0 Importing Track Logs

0 Keyword Searches
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What Location Data Can Do for You
Cameras equipped with location data features can embed the current longitude, 

latitude, altitude, and time (UTC, or Universal Coordinated Time) into pictures as 

they are taken. Location data can also be added to pictures using optional location 

data (GNSS) units or via the SnapBridge app.

Shooting locations can be displayed in map view ( ) in the viewer based on data 

provided by web map services.

View Shooting Locations
Location data embedded in pictures can be used to display shooting locations on a 

map (0 “Viewing Shooting Locations”, page 205).

 ❚ Editing Location Data
The location data embedded in pictures can be edited manually (0 “Editing 

Location Data”, page 208).

 ❚ Adding Location Data
Location data can manually be added to pictures with no embedded location data 

(0 “Adding Location Data”, page 211).
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 ❚ Adding Headings
Compass headings can be added to location data and existing headings can be 

edited (0 “Adding Headings”, page 214).

View Track Logs
Generate track logs from embedded location data.

 ❚ Straight Segments
Connect shooting locations using straight lines (0 “Straight Segments”, page 217).

 ❚ Trace Route
Scroll the map automatically to trace the track and the pictures you took on your 

photographic journeys (0 “Route Tracing”, page 218).

Import Track Logs
Download track logs from compatible cameras, smartphones, or third-party GNSS 

receivers (0 “Importing Track Logs”, page 220).

 ❚ Adding Pictures to Track Logs
Pictures with no location data can be added to existing track logs based on the time 

of recording (0 “Adding Pictures to Track Logs”, page 223).

 ❚ Adding Altitude/Depth Readings to Track Logs
Combine track logs with altitude or depth logs (0 “Adding Altitude/Depth 

Readings to Track Logs”, page 229).
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Perform Keyword Searches
Use location data to search the Internet for keywords that can be added to pictures 

as metadata (0 “Keyword Searches”, page 232).
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 D Points to Note When Using Maps

• The map display uses Google Maps.

• Metadata are provided via a service that obtains keywords from Wikipedia.

• Use of the map feature requires an Internet connection.

• Nikon accepts no liability for damages or other injury to the user or third 

parties arising from use of the map feature.

• The online map and keyword-search services used in the map feature are 

provided by third parties and are subject to change or cancellation without 

notice.

• Use of the map feature is accompanied by upload of longitude and latitude 

data to service providers.

• Be sure to read the terms of service before using Google Maps. A link to the 

Google Maps terms of service is available in map view.

• Nikon does not provide customer support for issues involving the use of 

Google Maps.

• The “add location data” and “edit location data” features are available only with 

photos (NEF, NRW, JPEG, and TIFF files).

• Depending on the accuracy of the original location data, the locations shown 

in map view may differ from the actual shooting locations.

• NX Studio supports location data conforming to the World Geodetic System 

(WGS 84) and Japanese Geodetic Datum (Tokyo Datum). The map may not 

accurately display locations recorded using other geodetic systems.

• Location data added or changed in NX Studio use the World Geodetic System 

(WGS 84).

• The geodetic system on which location data are based is listed under 

[Location Info] in the [Info] tab of the adjustments/info palette.

• This software uses the “Geonames web services” API.
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The Map Toolbar
Selecting map view ( ) displays the map toolbar in the viewer.

 Pin Tool
Select map pins (  or ) showing shooting locations.

 Edit Location Data
Add or edit location data (0 “Editing Location Data”, page 208).

 Edit Headings
Add or edit compass headings (0 “Adding Headings”, page 214).

 Show Route
Link shooting locations via straight lines (0 “Viewing Track Logs”, page 217).
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 Manage Logs
View selected track logs on the map. Selecting this button ( ) also displays 

options that can be used to manage track logs (0 “Importing Track Logs”, page 

220).

 Home
Return the map to the home position. The home position can be selected using 

the [Map] item in the [Options] dialog (0 “[Map]”, page 277).

 Re-center Map
Re-center the map on the current map pin ( ). If multiple pins or pictures are 

selected, the map will be redrawn to show all the selected items.

 Open in Browser
Display the current map in a web browser using an online map service. Map 

pins ( ) and other icons are not displayed. Note that some web browsers do 

not support Google Maps. For more information, see the online help for Google 

Maps.

 Options
Open the [Options] dialog to the [Map] section (0 “[Map]”, page 277).

 Search Area
Enter a place name or address. If a match is found, it will be displayed in the 

center of the map.
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Viewing Shooting Locations
Choosing map view ( ) when a folder containing pictures with embedded 

location data is selected displays the map. Shooting locations are shown by map 

pins (  or ).

 A Starting View

The starting view varies with the picture selected and the number of pictures 

with location data in the current folder. Display options are available via [Map] > 

[Shooting Location] in the [Options] dialog (0 “[Map]”, page 277).
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The filmstrip can be displayed using the filmstrip ( ) button in the view area. 

Pictures with embedded location data are indicated by  icons ( ). Selecting a 

picture centers the map on the pin ( ) showing its location ( ).

• Shooting locations for pictures not in the current selection are shown in yellow ( ). 

Clicking a yellow pin ( ) selects the picture and turns the pin red ( ).

• Multiple pins can be selected by pressing the control (or in macOS, command) 

key and clicking each pin in turn.

• The map can be scrolled using drag.

• Pictures taken in the same location are shown by a single pin ( ). At some scales, 

pictures taken in different locations but in close proximity may also be displayed 

as a single pin ( ).
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Viewing Metadata
Clicking a pin ( ) on the map displays a pop-up listing metadata for the selected 

picture.

• The pop-up contains a [Photo] tab giving the file name and showing the picture 

as a thumbnail. In the case of videos, the thumbnail shows the clip’s first frame.

• The camera name, date of recording, and other metadata for the picture are listed 

in a [Metadata] tab. Compass headings, points of interest, and other added data 

are also listed if available.

• Where multiple pictures recorded in the same location or in close proximity are 

shown by a single pin ( ), you can page through the images by clicking  or .

• The pop-up can be closed by clicking the map or by clicking the  button at the 

top right corner of the pop-up.
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Editing Location Data
You can edit the location data embedded in pictures while viewing locations on the 

map. NX Studio can also be used to delete location data or add them to pictures for 

which no data had previously been recorded.

Editing Location Data
The location data embedded in pictures can be edited manually.

1. Select the picture in the filmstrip or click its pin ( ) on the map. You can edit 

the location data for only one picture at a time.
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2. Enable ( ) the edit location data button in the toolbar. The map pin for the 

selected picture will change from  to .

3. Drag the pin to the desired location. A confirmation dialog will be displayed.
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4. Click [OK] to update the location data; the pin will revert to .
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Adding Location Data
Location data can manually be added to pictures for which no data had previously 

been recorded.

1. Select the picture in the filmstrip.

2. Display the desired location on the map and enable ( ) the edit location data 

button in the toolbar. A “+” symbol will be displayed on the cursor.
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3. Click the desired location; a confirmation dialog will be displayed.

4. Click [OK] to add the location data to the selected picture.
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 AAdding Location Data: Tips

• Data for a chosen location can be added simultaneously to multiple selected 

pictures.

• Location data can also be copied from one picture and pasted to another. 

Select a picture with location data in the filmstrip and select [Metadata] > 

[Copy Location Data] in the [Image] menu. Select the target picture and 

choose [Paste Location Data] to paste the location data from the clipboard.

 ADeleting Location Data

• To delete location data from a picture, select it in the filmstrip or click its pin  

( ) on the map and then select [Metadata] > [Delete Location Data] in the 

[Image] menu.

• Deleting location data for a selected pin ( ) deletes the location data for all 

pictures at that location.
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Adding Headings
You can add compass headings to pictures. If the picture was taken with a camera 

that supports compass headings, you have the option of editing the existing data. 

When a picture with a compass heading is selected, the map pin will change from 

 to .

1. Select the desired picture in the filmstrip or click its pin ( ) on the map. You 

can add or edit compass headings for only one picture at a time.
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2. Enable ( ) the edit compass heading button in the toolbar. The existing 

heading, if any, will be shown by an arrow.

3. Drag to select the desired heading.
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4. A confirmation dialog will be displayed. Click [OK] to update the location data; 

if you added a compass heading, the pin will change to . The arrow will be 

re-oriented to the new heading.

 ADeleting Compass Headings

• In addition to [Cancel] and [OK] options, the confirmation dialog for pictures 

with existing compass heading data contains a [Delete] option that can be 

used to delete the compass heading.

• You can also delete the compass heading using [Metadata] > [Delete 
Heading] in the [Image] menu.
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Viewing Track Logs
A track of your photographic journeys can be generated by joining selected 

pictures with straight lines.

Straight Segments
Enabling ( ) the show route tool when two or more pictures with location data are 

selected displays a track showing the straight-line distance between each pin ( ).

• The scale will be adjusted to fit all the selected pins on the map.

• At default settings, the pins are joined in order by date of recording. To instead 

join the pins in the order selected, choose [Connect pins in selection order] for 

[View Path] in the [Map] section of the [Options] dialog (0 “[Map]”, page 277).
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Route Tracing
After generating a straight-line route, you can scroll the map automatically to trace 

its track, with the current position on the route shown by a  icon. Each of the 

pictures you took will be displayed in turn as you follow your photographic journey.

• When the “show route” button is enabled ( ) in the map toolbar, a  icon will be 

displayed. Clicking  displays an icon representing a human figure ( ) following 

the route.

• When the figure ( ) reaches a map pin ( ), it will pause and a pop-up will be 

displayed showing the pictures taken at that point.
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• Route tracing can be paused or ended by clicking  or  in the map toolbar.

• When the figure ( ) reaches the final pin ( ), route tracing will end and the figure ( ) 

will no longer be displayed.

• Display of the photos when the figure ( ) reaches each pin ( ) can be disabled by 

removing the check from [View Path] > [Show pop-ups while icon is moving] 

in the [Map] section of the [Options] dialog (0 “[Map]”, page 277).
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Importing Track Logs
Compatible cameras, smartphones, and GNSS receivers acquire location data from 

GNSS satellites at regular intervals. Track logs created from these location data can 

be loaded into NX Studio and displayed on the map.

 D Track Logs

For information on saving and uploading track logs, see the documentation for 

your camera, smartphone, or GNSS receiver.

 A Supported Formats

The following track log file types are supported:

• NMEA (extensions “.nmea”, “.nma”, “.log”)

• GPX (extension “.gpx”)

Opening and Viewing Track Logs
Copy the track logs to the computer using a card reader or the like.

1. Enabling “view track logs” ( ) in the map toolbar displays [Log Matching] 

controls.
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2. To add a track log, click [Add] under [Track Log File] and choose the desired 

file to display the track on the map.

3. The start and end of the track are shown by start ( ) and end ( ) pins.
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 A Importing Track Logs

• The log matching list shows up to ten track logs at a time. Tracks can be 

displayed by selecting the logs in the list.

• To view or hide tracks, click the adjacent check boxes ( ) on or off.

• Logs currently selected in the list can be removed by clicking the [Remove] 

button under [Track Log File].
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Adding Pictures to Track Logs
Pictures can be matched to positions on track logs by date and time of recording. 

Location data can be added simultaneously to multiple pictures for which none 

previously existed.

1. Select a folder containing pictures recorded at dates and times matching those 

of the track log, display the filmstrip, and click the [Run] button under [Log 
Matching].

 D Location Data

Location data will be added to pictures taken while tracking was active or 

within one hour of the log’s start or end.
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2. The thumbnails for pictures shot in the time spanned by the log are indicated by 

check marks ( ) and map pins ( ).

 D Pictures That Cannot Be Assigned Location Data

Pictures that cannot be assigned location data are indicated by  icons.

 D Track Points

The points on the track log where location data were acquired from GNSS 

satellites are referred to as “track points”. Track points are added at set 

intervals not directly linked to picture recording times. At default settings, 

pictures are matched to the track points with the times most closely 

matching the times the pictures were taken. The matching between 

pictures and track points can be adjusted via [Log Matching] in the 

[Options] dialog (0 “Matching Options”, page 227).
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3. Click thumbnails to view picture locations; the pins for selected pictures are 

displayed in red ( ). Conversely, clicking map pins selects the thumbnails for 

the associated pictures.

 A Removing Matches

Pictures can be removed from the map by removing the checks from the 

thumbnails, in which case no location data will be added to the pictures.
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4. To add location data to the selected pictures, click the [Save] button under 

[Log Matching] and then click [Yes] when prompted.

5. Location data icons ( ) will appear on the thumbnails.

 AManipulating Location Data

The location data added to pictures can be edited manually (0 “Editing 

Location Data”, page 208).
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 ❚ Matching Options
To choose how NX Studio matches pictures to track points after you click the Log 

Matching [Run] button, use the [Assign Location] options in the [Log Matching] 

section of the [Options] dialog.

The example that follows shows how the different options determine how 

NX Studio assigns location data to a picture taken at 10:32 based on track points 

recorded at 10:30 (a) and 10:35 (b).

[Nearest track point (single point)]
Pictures are matched to track points with the times most closely matching the 

times the pictures were taken. In this case, the location data for track point (a) 

will be added to the picture.
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[Last and next track points (two points)]
NX Studio calculates a shooting location for each picture based on the 

difference between the time of recording and the times for the two closest track 

points. In this example, the picture will be assigned a position two fifths of the 

way between points (a) and (b).
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Adding Altitude/Depth Readings to Track Logs
Track logs can be combined with altitude/depth logs recorded with Nikon digital 

cameras. Altitude or depth data will be added to track points in the track log.

 AAltitude/Depth Logs

• Altitude/depth logs are produced by Nikon digital cameras equipped with 

altimeters or depth sensors that record the altitude or depth at set intervals.

• The location and altitude or depth recorded at each interval is referred to as a 

“track point”.

1. In the [View] menu, select [Map Display Options] > [Merge Altitude and 
Track Logs].

2. Click [Select] and choose a track log. The track log file name, file type, and start 

and end times appear in the track log file list.
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3. Click [Add] and choose an altitude/depth log.

 AAltitude/Depth Logs

• The log matching list shows up to ten altitude/depth logs at a time. Tracks 

can be displayed by selecting the logs in the list.

• To view or hide tracks, click the adjacent check boxes ( ) on or off.

• Logs currently selected in the list can be removed by clicking the 

[Remove] button next to [Altitude/Depth Log File].
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4. Click [Save] to merge the logs and exit the [Merge Altitude Log with Track 
Log] dialog.

 DAltitude/Depth Data

At default settings, altitude/depth readings are matched to track points with 

the times most closely matching the times the readings were recorded. 

The matching between altitude/depth readings and track points can 

be adjusted via [Log Matching] in the [Options] dialog  (0 “Matching 

Options”, page 227).
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Keyword Searches
The location data recorded with pictures can be used to search the Internet for 

place names and other keywords pertaining to each location. Keywords so found 

can be added to picture metadata.

1. Select the desired picture in the filmstrip or click its pin ( ) on the map and 

select [Get from Location Data] in the adjustments/info palette [XMP/IPTC] 

tab. A keyword-selection dialog will be displayed.
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2. Select keywords in the [Address] or [Wikipedia] tab and click [Add]. Up to 

100 keywords can be added to each picture.

3. Selected keywords can be edited by clicking them in the list or deleted by 

clicking the [Delete] button.
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4. Click [OK] to add the keywords to the “keywords” field in the [XMP/IPTC] tab. 

The changes are applied when the picture is saved.

 ADeleting Keywords

To delete keywords from the [XMP/IPTC] tab, mouse over the terms in the 

“keywords” field and click .
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The [Wikipedia] Tab
NX Studio locates keywords by searching the titles of articles posted to “Wikipedia”, 

an online encyclopedia. When you click [Get Keyword], NX Studio searches the 

titles of articles referencing locations near the point where the picture was recorded 

and displays a list of the keywords so found.

 A Finding Keywords

• NX Studio can only conduct keyword searches when connected to the 

Internet and may be unable to locate keywords for some locations.

• Search results may not be correct.
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Slide Shows

0 Viewing Selected Pictures
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Viewing Selected Pictures
To view the current selection or the pictures in the current folder in a slide show, 

click [Slideshow] in the toolbar.

When prompted, adjust settings and click [OK] to start the show.
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Slide Show Settings
The options in the [SlideShow] dialog control how long pictures are displayed, the 

transitions between slides, and other slide show settings. After adjusting settings, 

click [OK] to start the show.

[Style]
Choose the transitions between slides.

[Still image duration]
Choose how long each of the photos in the slide show is displayed; your 

options are [Short], [Standard], and [Long] (equivalent to about 3, 5, or 10 

seconds, respectively).

[Add background music]
Select this option to add background music in the form of an audio file. To 

choose the file, click [Browse]. Only one background track can be used at a 

time.

[Include Videos]
Select this option to include any videos in the current selection in the slide 

show.

[Repeat]
If this option is selected, the slide show will repeat until stopped.
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Slide Show Controls
The controls displayed during the show differ from those that appear at its end.

 ❚ During the Show
Click anywhere on the current picture to end the show. Moving the mouse during 

the show displays playback controls. The  control can also be used to end the 

show.

 A [Create Video]

Clicking [Create Video] in the slide show controls displays a dialog where 

you can save the slide show as a video using the currently-selected pictures, 

background music, and transitions (0 “Combining Photos and Videos”, page 

169).
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 ❚ After the Show
A list of options will be displayed when the slide show ends. Among the actions 

that can be performed are repeating the show and adjusting settings. Clicking 

[Create Video] displays a dialog where you can save the slide show as a video 

(0 “Combining Photos and Videos”, page 169).
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Uploading Pictures to the Web

0 Web Services

0 NIKON IMAGE SPACE

0 YouTube
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Web Services
Photos and videos can be uploaded directly from NX Studio to NIKON IMAGE SPACE 

or YouTube.

 ANIKON IMAGE SPACE

NIKON IMAGE SPACE is an online service for storing, sharing, and organizing 

photos, videos, and other files. Special privileges are granted to owners of Nikon 

digital cameras. For more information, visit the NIKON IMAGE SPACE website.

https://www.nikonimagespace.com/

Logging In
In order to upload pictures you must first log in to the upload site. Enter your 

login information in the [Web Service] section of the [Options] dialog (0 “[Web 

Service]”, page 282).
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Uploading Pictures
Select pictures and click [Upload] in the toolbar to initiate upload.

• If you are not currently logged in, you will be prompted to do so. Clicking [Login] 

displays the [Web Service] section of the [Options] dialog.

• Click [Upload] and choose a web service when prompted. Upload settings for 

the selected service will be displayed.

• If you selected NIKON IMAGE SPACE, you will be able to choose one or more 

pictures for upload in the filmstrip or thumbnail display.
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NIKON IMAGE SPACE
Selecting [NIKON IMAGE SPACE] in the web-services–selection dialog displays 

upload settings.

[Upload Settings]
Adjust settings for pictures uploaded from NX Studio.

• [Image Settings (Resize)]: Choose the size at which pictures will be 

uploaded.

• [Select Album]: Choose a destination for the uploaded pictures. To upload 

pictures to a new album, select [New Album] and enter the album name.

 – [Add XMP/IPTC keywords as NIKON IMAGE SPACE tags]: Select this 

option to add image tags for the [Keywords] in the [XMP/IPTC] tab of the 

adjustments/info palette (0 “The Adjustments/Info Palette”, page 24). 

Tags can be used for keyword searches in NIKON IMAGE SPACE.

 – [Add XMP/IPTC rating as NIKON IMAGE SPACE rating]: Select this 

option to keep the currently-selected ratings when pictures are uploaded 

(0 “Rating Pictures”, page 66).

[Start]
Upload the pictures to NIKON IMAGE SPACE at the selected settings.

[Cancel]
Exit without uploading the pictures.
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 A Supported File Types

For information on the types of files that can be uploaded, see NIKON IMAGE 

SPACE online help.
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YouTube
Selecting [YouTube] in the web-services–selection dialog displays video upload 

settings.

[Upload Settings]
Adjust settings for videos uploaded from NX Studio.

• [Title]/[Description]: Enter a title and description for the video.

• [Tags]: Enter tags for the video.

• [Category]: Choose a category for the video.

• [Privacy Setting]: Choose privacy settings for the video.

[Start]
Upload the video to YouTube at the selected settings.

[Cancel]
Exit without uploading the video.
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 DUploading Videos

• The video must be no more than 15 minutes long.

• Only one video can be uploaded at a time.

 A Supported File Types

Videos can be uploaded to YouTube in MOV, AVI, and MP4 formats.
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Printing

0 Printing Pictures

0 Printing Image Information

0 Index Prints
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Printing Pictures
To print pictures on a printer connected to the computer, select the pictures and 

click [Print] in the toolbar.

The [Print] dialog will be displayed.

 ANotes on Printing

• To save the JPEG file currently displayed in the preview area, click [File 
Output].

• The most recently-used settings are recalled when the print dialog is next 

displayed.

 A Epson Printers

If installed, the Epson Easy Photo Print utility or Epson Print Layout plugin can 

be launched from NX Studio by clicking the [E-Photo] or [Epson Print Layout] 

icon in the toolbar. For more information on Easy Photo Print or Epson Print 

Layout, see the documentation provided by Epson or visit the Epson website.
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The “Print” Dialog
Adjust printer and layout settings.

[Print Type]
Choose the number of pictures printed per page.

• [Full Page]: Print one picture per page.

• [Index Print]: Print multiple pictures per page (0 “Index Prints”, page 257).

• [Standard Photo Sizes]: Print pictures at a standard photo size. The size 

can be selected from the [Photo Size] menu in the [Page Layout] panel. 

NX Studio automatically chooses the number of pictures printed per page.
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[Printer Setup]
Choose the printer and adjust other printer settings, including print quality and 

the number of copies of each page printed.

• [Printer]: Click [Settings] to adjust printer settings. The dialog lists the printer 

and the option currently selected for paper size.

• [Printer Type]: Choose [Inkjet] when printing on an inkjet printer.

• [Print Priority]: When printing RAW (NEF/NRW) pictures, choose [Speed] to 

use the preview data embedded in the image for faster printing, or [Quality] 

to use the original image data for higher quality output. The only option 

available when [Index Print] is selected for [Print Type] is [Speed].

• [Copies]: Choose the number of copies of each page printed.

[Page Layout]
Adjust the layout of the pictures printed on each page.

• [Resize Image]: When printing one picture per page, use the slider to adjust 

picture size.

• [Rotate to fit]: Rotate pictures to print them at the largest possible size.

• [Crop images to fit]: Pictures are enlarged to fill the print area. Portions that 

do not fit in the print area are cropped out.

• [Background Color]: Choose the background color. Choose [White] to print 

with no background.

• [Border width]: Choose the width of the borders printed around the image. 

The color of the borders (black or white) varies with the option selected for 

[Background color]. Choose [0] to print without borders.

• [Copies of each image]: Choose the number of copies of each photo 

printed.

• [Print information]: Print the file name, date of recording, or photo 

information under each picture (0 “Printing Image Information”, page 253).

• [Use thumbnail data (draft mode)]: Print using thumbnail data. Images 

print faster, but at lower quality. Some images will print using the original file 

data even when this option is selected.
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• [Specify color profile]: Print using a specified color profile. To choose a color 

profile, click [Settings].

 – [Print profile]: Select a color profile for printing.

 – [Intent]: Choose from [Perceptual] and [Relative colorimetric] 

(0 “Intent”, page 271).
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Printing Image Information
To choose the information printed under each picture, select [Print information] 

in the “Print” dialog and click [Settings].

 D Print Information

Print information is not rotated when [Rotate to fit] is selected in the “Print” 

dialog.
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Advanced Print Information Settings
Choose the information to be printed in the [Date/Time Shot and Comment], 

[Metadata], and [Header/Footer] tabs of the “Advanced Print Information Settings” 

dialog.

The [Date/Time Shot and Comment] Tab
Choose whether to print the date and/or time of recording and user comments.

• [Date Shot]: Print the date of recording in the position selected for 

[Position].

• [Time Shot]: Print the time of recording.

• [User Comment]: Print the comment entered in the text box.

• [Font Settings]: Choose the font, style, font point size, and color used to 

print the date/time stamp.

• The results can be previewed in the [Sample] area.
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The [Metadata] Tab
Choose the metadata printed with each picture. The options available are 

limited to a portion of the shooting information.

• [Font Settings]: Choose the font, style, and point size used to print metadata.

• The results can be previewed in the [Sample] area.

 DMetadata

Some of the fields selected in the [Metadata] tab may not be printed depending 

on the space available.
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The [Header/Footer] Tab
Choose the information printed at the top and bottom of each page.

• [Header]: Enter the text and choose the alignment for the header that will be 

printed at the top of each page.

• [Page Number]: Choose whether to print the page number. The page 

number can be printed at the top or bottom of the page. It will appear in the 

header if printed at the top and in the footer if printed at the bottom. To print 

page number as “Page <current page> of <total number of pages>”, select 

[Page Total (1 of 2)].
• [Footer]: Enter the text and choose the alignment for the footer that will be 

printed at the bottom of each page.

• [Font Settings]: Choose a font, style, and point size for the header, footer, 

and page number.

• The results can be previewed in the [Sample] area.
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Index Prints
To print multiple images per page, select [Index Print] for [Print Type]. You can 

choose the image size and number of pictures printed per page.

[Layout]
Choose a layout.

• [Standard]: Choose the number of pictures per page from a list box. The size 

of the pictures is automatically adjusted according to the option selected.

• [Image Size]: Pictures are printed at the size entered for [Width] and 

[Height]. The number of pictures per page is automatically adjusted 

according to the size selected.

• [Column and Row]: Choose the numbers of [Column] and [Row] printed 

per page. The size of the pictures is automatically adjusted according to the 

options selected.

• [Images Per Page]: Choose the number of images printed per page. Pictures 

are automatically resized to fit the selected number of pictures to the page.

[Margins]
Choose the width of the margins using the slider.
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Exporting Pictures

0 Saving Pictures in Other Formats
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Saving Pictures in Other Formats
To export the pictures in the current selection in JPEG or TIFF format, click [Export] 

in the toolbar. Exporting RAW (NEF/NRW) pictures as JPEG or TIFF files allows them 

to be used with other software. If desired, entire folders can be selected for export.

 D RAW Pictures

[Export] can be used to save RAW pictures in other formats. To save RAW pictures 

without converting them to other formats, use [Save] or [Save As] in the [File] 

menu. More options for use when saving pictures can be found in the [Save] 

section of the [Options] dialog (0 “[Save]”, page 284).
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Choose a format, adjust image quality, size, and other settings, and click [Export] to 

export the files to a selected folder.

[Original Image]
Export the pictures in the current selection or in selected folders.

• [Selected images]: Export the pictures in the current selection.

• [Selected folder]: Export all pictures in a selected folder. To choose the 

folder, click [Browse].

 – [Include subfolders]: Include pictures in all sub-folders under the 

selected folder.

 – [Delete originals after operation]: Delete the original pictures from the 

folder once export is complete.
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[Export as]
Choose a format for the exported files from [JPEG], [TIFF (8 Bit)], and [TIFF (16 
Bit)].
• [Quality]: Drag the slider or enter a value to choose the compression ratio 

when exporting pictures in JPEG format.

• [Use LZW Compression]: Compress TIFF files using a lossless LZW 

compression algorithm.

 D LZW Compression

Enabling LZW compression when converting pictures to 16-bit TIFF may 

increase file size.

[Change image size]
Resize pictures during export. Entering a value for [Long edge] automatically 

updates [Short edge] to maintain aspect ratios. The size cannot be larger than 

the picture’s original size.

[Remove camera setting information]
Strip shooting data from pictures during export.

[Remove XMP/IPTC information]
Strip XMP/IPTC information from pictures during export.
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[Add/Remove ICC color profile]
To add or remove color profiles, select this option and choose [Add] or 

[Remove]. The profiles added when [Add] is selected vary with the option 

selected for [Color Management] in the [Options] dialog (0 “[Color 

Management]”, page 270):

• If only [Use this instead of an embedded profile when opening images] 

is selected, the [Default RGB color space] profile (or in macOS, [RGB 
Default Profile]) will be embedded in pictures during export.

• If only [Convert images to sRGB color space when they are converted 
into JPEG/TIFF format] is selected, the sRGB color profile will be embedded 

in pictures during export.

• If both are selected, the sRGB color profile will be embedded in pictures 

during export.

• If neither is selected, the original color profile will be embedded in pictures 

during export.

[Save in]
Choose the destination folder for the exported pictures.

• [Same folder as originals]: Save the exported pictures to the same folders 

as the original files.

• [Specified folder]: Save the exported pictures to a selected folder. To choose 

the destination, click [Browse].

 – [Create a new subfolder for each export]: Automatically create a new 

sub-folder within the chosen folder each time pictures are exported. To 

choose how the folders are named, click [Naming Options].

[Change file names]
Rename files during export. To choose how the files are named, click [Naming 
Options].
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Options

0 The Options Dialog

0 [General]

0 [Thumbnail]

0 [Viewer]

0 [Favorite Folders]

0 [Dialog/Alert]

0 [Color Management]

0 [Levels & Sampling]

0 [Open with Application]

0 [XMP/IPTC Preset]

0 [Labels]

0 [View]

0 [Map]

0 [Log Matching]

0 [NEF (RAW) Processing]

0 [Web Service]

0 [Video] (Windows Only)

0 [Save]
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The Options Dialog
The settings in this dialog are used to tailor the default behavior of NX Studio to 

your taste. They can be accessed by selecting [Options] from the [Edit] menu 

(Windows) or by choosing [Options] in the [NX Studio] menu (macOS).
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[General]
A catch-all category for options pertaining to general NX Studio operations.

[Voice Memo]
Select [If the image displayed in Full Screen Mode has a voice memo, 
always play the voice memo] to automatically play voice memos appended 

to pictures displayed full-screen.

[Notification Audio]
If [Beep when process is complete] is selected, NX Studio will make a sound 

when processing is complete. The sound can be selected from the list.

[Thumbnail Cache]
Adjust thumbnail cache settings as described below.

• [Clear Cache]: Delete the display cache.

• [Cache Location]: The current cache location. To choose a different location, 

click [Browse] and navigate to the desired folder.

[Restore Defaults]
Reset all items in the [General] category to their default values.
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[Thumbnail]
Adjust thumbnail-related settings.

[Folder Icons in Thumbnail Area]
Choose whether and in what order sub-folders appear in the thumbnail grid, 

thumbnail list, and filmstrip displays.

• [Display folder icons first]: Sub-folders are listed first, before pictures.

• [Display folder icons last]: Sub-folders are listed last, after pictures.

• [Hide folder icons]: Sub-folders not listed.

[Restore Defaults]
Reset all items in the [Thumbnail] category to their default values.
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[Viewer]
Adjust viewer settings.

[Scale with Shift Key]
In the viewer, “2/4 images”, and before-and-after displays, you can quickly zoom 

in by clicking pictures or holding the shift key. The zoom ratio can be selected 

from options listed.

[View Mode]
Choose view-mode-selection options for the viewer, “2/4 images”, and before-

and-after displays.

• [Choose the view mode accessed by double-clicking thumbnails]: 

Choose whether double-clicking a thumbnail in the thumbnail grid or 

thumbnail list displays the picture full-screen or in the image viewer.

• [When viewing images full-screen in a multi-display environment]: 

Choose the monitor used to display the selected image when you double-

click a thumbnail with [Full Screen] selected for [Choose the view mode 
accessed by double-clicking thumbnails] in a multi-display environment.

[Restore Defaults]
Reset all items in the [Viewer] category to their default values.
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[Favorite Folders]
Choose whether default folders are included in the [Favorite Folders] list.

[Default Folders]
Select [Display default folders] to include default folders in the folders listed 

under [Favorite Folders] in the browser palette. To list the default folders first, 

select [Display default folders at the top].

[Restore Defaults]
Reset all items in the [Favorite Folders] category to their default values.
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[Dialog/Alert]
Choose whether to reset the [Don't show this dialog again] check boxes for all 

dialogs.

[Dialog Windows]
Click [Reset] to reset the [Don’t show this dialog again] check boxes for all 

dialogs.
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[Color Management]
Adjust color management settings.

[Color Matching Profile] (Windows)/[Default Profiles for images] (macOS)
Adjust color space (color profile) settings.

• [Default RGB color space] (Windows)/[RGB Default Profile] (macOS): 

Choose the default RGB profile.

 – [Use this instead of an embedded profile when opening images]: 

When opening pictures, replace the embedded color profile with the 

profile selected for [Default RGB color space] (or in macOS, [RGB 
Default Profile]).

[Printer Profile]
[Use this profile when printing]: Select this option to choose a color profile 

for printing.

• Choose the printer profile used for printing.

• Choose the intent from the [Intent] menu.

[Display Profile] (Windows)/[Device Profiles] (macOS)
Click [Change Display Profile] to choose a monitor profile. Options for your 

operating system will be displayed.
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[Output]
Select [Convert images to sRGB color space when they are converted into 
JPEG/TIFF format] to embed the sRGB color profile in pictures converted to 

other formats during export. The original color profile is overwritten.

[Thumbnail]
Select [Apply color management settings to thumbnails] to apply color 

management settings to the thumbnails in the thumbnail grid, thumbnail list, 

and filmstrip.

 A Intent

• [Perceptual] maintains the relations between colors to produce results that 

seem natural to the human eye. The colors may however not be true to the 

original image data.

• [Relative colorimetric] maps colors not in the selected profile to the nearest 

available color. All colors in the gamut of the printer will be reproduced 

accurately.
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[Levels & Sampling]
The settings in this category apply to the [Levels & Curves] and sampling tools.

[Levels & Curves]
[Auto Contrast Clip]: The auto-contrast clip option in the [Adjustments] tab 

[Levels & Curves] tool increases contrast by setting the shadow and highlight 

points to exclude a set proportion of the darkest and brightest pixels in the 

image. Choose the percentage of pixels excluded by the new [Shadows] and 

[Highlights] points (0 “The Levels and Tone Curves Tool”, page 103).

[Sampling]
[Sample Size]: Select the size of the area sampled by the [White Balance] 

gray point and [Levels & Curves] sampling controls in the [Adjustments] tab 

(0 “The White Balance Tool”, page 96, and “The Levels and Tone Curves Tool”, 

page 103).

[Restore Defaults]
Reset all items in the [Levels & Sampling] category to their default values.
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[Open with Application]
Edit the list of software that can be accessed via the [Other Apps] button in the 

toolbar.

 Application List
Click [Add] to add software to the list.

 [Video settings]
Choose the software used to play videos.

• [Play in NX Studio]: Play videos in the NX Studio preview display.

• [Play with the associated application by double-clicking]: Double-

clicking a video displays it using software associated with that file type in the 

operating system.
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[XMP/IPTC Preset]
Manage XMP/IPTC presets.

 Preset List
A list of existing presets.

 [New]/[Duplicate]/[Delete]
Create, duplicate, or delete XMP/IPTC presets.

 Category Check Boxes
Select or deselect all items in the chosen category.

 Item Check Boxes
The selected items will be added to picture metadata during download. 

Selecting an item while leaving the field blank sets the field to “Clear”. Any 

previously-chosen values for the selected item will be deleted when the 

pictures are downloaded.

 [Check all]
Select or deselect all items in the XMP/IPTC preset.
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[Labels]
Name labels.

[Customize Label names]
Select [Use default values] to use the default label names. Deselect this option 

to choose custom label names.
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[View]
Adjust NX Studio display options.

[Size of Text and Icon]
Choose the size of the letters and icons in the user interface.

[Background Color]
Choose the background color for the image viewer and for the filmstrip, 

“2/4-images”, and before-and-after views.

[Grid]
Choose options for the reference grid.

• [Color]: Choose the grid color.

• [Grid Interval]: Choose the grid spacing.

• [Subdivisions]: Choose the number of subdivisions in each square.

[Restore Defaults]
Reset all items in the [View] category to their default values.
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[Map]
Adjust map display settings.

[Server Connection]
Choose a map server for the map display.

• [Always connect to this server]: Always connect to the selected server.

• [Connect to automatically selected server]: Automatically select the 

server for your country or region from those in the [Always connect to this 
server] menu based on your current IP address. If unable to select a server 

based on your IP address, NX Studio will select a server based on information 

from the operating system. The United States server will be used if no server 

for your country or region is available in the [Always connect to this server] 

menu.
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[Home Location]
The location displayed when you click  in the map display toolbar can be 

set as the home position. The home position will be displayed if there are no 

location data for the pictures in the current folder.

• [Set automatically]: Set the home position automatically.

 – [Set using the country and region of the operating system]: The 

home position is chosen based on the country and region settings for the 

operating system.

 – [Set using the IP address]: NX Studio chooses a home position based 

on your current IP address. If unable to select a position based on your IP 

address, NX Studio will select a position based on information from the 

operating system.

• [Set manually]: Select [Use Current Location] to set the home position 

and scale to the portion of the map currently displayed.

• [Use world map]: Set the home position to a view of the entire globe.

[Shooting Location]
Switching to map view when a picture with embedded location data is selected 

displays a pin ( ) showing the picture’s location. Choose the display shown 

when the current folder contains multiple pictures with embedded location 

data.

• [Show the locations of all images in the folder]: NX Studio shows pins for 

all pictures in the folder.

• [Show the locations of the selected images in the folder]: NX Studio 

shows pins only for the pictures in the current selection.
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[When images with location data are selected]
Choose whether NX Studio re-centers the map on the shooting locations when 

pictures with location data are selected.

• [Scroll and zoom the map to encompass all the corresponding pins]: 

NX Studio re-centers the map to show shooting locations. If multiple pictures 

with shooting data are selected, the scale will be adjusted to show the 

locations of all the selected pictures.

• [Do nothing]: Selecting pictures with location data does not re-center the 

map. The map can still be re-centered on selected pictures by clicking  in 

the map toolbar.

[View Path]
Show straight-line paths connecting selected pictures either in the order taken 

([Connect pins in shooting order]) or in the order the pictures were selected 

([Connect pins in selection order]; 0 “Viewing Track Logs”, page 217).

• [Show pop-ups while icon is moving]: When route playback reaches a pin 

for a picture with location data, display a preview of the picture in a pop-up 

window.
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[Log Matching]
Adjust settings for track logs.

[Unit for Altitude/Depth]
Choose the units used in the graph showing changes in elevation and depth. 

Selecting [Use computer setting] matches the units to those selected for the 

operating system.

[Time Zone]
Choose the time zone for the location in which pictures were recorded, 

expressed as the difference, in hours and minutes, between UTC and the time 

zone in the location.

[Assign Location]
Choose how NX Studio behaves when adding location data to pictures based 

on track logs (0 “Importing Track Logs”, page 220).
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[NEF (RAW) Processing]
Adjust settings for processing RAW pictures.

[Color Space for Color Reproduction]
Choose the color space used for adjustments to RAW pictures.

[Sizes Medium/Small for NEF (RAW) Images]
Select [Perform recommended processing] for optimal processing when 

editing [Small] and [Medium] RAW pictures.

[D1X RAW Default]
Choose the default display size for RAW photos taken with the D1x.

[Color Reproduction Process]
Choose a color reproduction process.
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[Web Service]
Enter login settings for web services. Log in before uploading pictures 

(0 “Uploading Pictures to the Web”, page 241).

 [NIKON IMAGE SPACE]
Log in to NIKON IMAGE SPACE using your registered e-mail address and 

password.

• Select [Save password] to log in to NIKON IMAGE SPACE automatically in 

future.

• To open NIKON IMAGE SPACE in a web browser, click [NIKON IMAGE SPACE]. 

Use this option to register for NIKON IMAGE SPACE if you do not already have 

an ID.

 [YouTube]
To enter the information needed when logging in to YouTube via the [Upload] 

button in the toolbar, click [Authenticate].
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[Video] (Windows Only)
Adjust settings for video playback.

[Playback]
Choose whether video playback gives priority to color reproduction or to 

maintaining an even playback speed. Select [Favor frame rate] for smooth 

playback.
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[Save]
Choose how pictures are saved. Image adjustments in NX Studio can be saved to 

“sidecar” files or applied directly to the pictures.

“Sidecar” Files
To save image adjustments to “sidecar” files, choose [Save adjustments to an 
adjustments (sidecar) file] for [Save Type]. Any changes to pictures will be saved 

in image adjustment (sidecar) files (extension “.nksc”) separate from the original image 

data. Because changes are not applied directly to the original image data, even JPEG 

files can be edited with no loss in quality. Sidecar files are also used to store labels, 

ratings, XMP/IPTC metadata, and other data in addition to image adjustments. Pictures 

can be restored to their original states at any time by deleting the sidecar files.

.nksc
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Use of sidecar files has the following advantages:

• Sidecar files are updated as pictures are edited.

• Edits apply only to the sidecar files, allowing large RAW images to be processed 

quickly and efficiently.

• Edits can be hidden and restored at any time. Individual adjustments can be 

saved separately.

• Adjustments can be applied to other pictures, saving users the trouble of making 

the same edits over and over again.

• Pictures can be exported as JPEG or TIFF files for use with software that does not 

support sidecar files (0 “Exporting Pictures”, page 258).

 AAdjustment Files

Image adjustments are saved to sidecar files in an “NKSC_PARAM” folder within 

the same folder as the original image.

• All changes will be lost if the sidecar file or “NKSC_PARAM” folder is deleted.

• Pictures and sidecar files are linked via the file name. Changes will 

consequently be lost or applied to another picture if the files are renamed. Use 

the file management features in NX Studio to rename, move, copy, or delete 

files or folders.

• To apply adjustments after transferring pictures to a different device, you 

will need copy both the pictures and the associated sidecar files and open 

the pictures in NX Studio. Note that you will need to copy the entire “NKSC_

PARAM” folder.
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Original Files
To save adjustments to the same file as the original image data, choose [Save 
adjustments to the original image file] for [Save Type]. Adjustments and 

metadata are variously applied directly to or stored together with the original image 

data. The absence of sidecar files means that pictures can easily be handled on 

other devices or using other software. Adjustments are handled in one of two ways, 

depending on the file type.

 ❚ RAW (NEF/NRW) Files
The files contain a record of all image adjustments, allowing previous changes to 

be edited the next time the file is opened. You can also undo any or all adjustments 

and restore the original file at will.

• RAW files must be saved in JPEG or TIFF format before they can be opened using 

other software (0 “Exporting Pictures”, page 258).

• Edits will not be visible if the files are copied to a memory card and viewed on 

the camera.
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 ❚ JPEG and TIFF Files
Image adjustments are applied directly to the original image data when the 

pictures are saved. Any previous changes are overwritten, meaning that the pictures 

cannot be restored to their original states.

• Any changes made in NX Studio will be visible when the files are opened using 

other software.

• If desired, you can remove the check from [Do not save original JPEG/TIFF 
images to subfolder] to save a backup copy of the original, unedited image 

data. The backup copy will be stored in an “_Original” folder in the same folder as 

the edited picture.
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Menu List

0 The [File] Menu

0 The [NX Studio] Menu (macOS Only)

0 The [Edit] Menu

0 The [Browser] Menu

0 The [Image] Menu

0 The [Adjust] Menu

0 The [View] Menu

0 The [Window] Menu

0 The [Help] Menu
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The [File] Menu

[Transfer Pictures]
Launch Nikon Transfer 2.

[Take Pictures Remotely Using Camera Control Pro 2]
Launch Camera Control Pro 2. This option is displayed only if Camera Control Pro 2 

is installed.

[Take Pictures Remotely with NX Tether]
Launch NX Tether. This option is displayed only if NX Tether is installed.

[Show Image Immediately After Shooting]
If this option is enabled, pictures will automatically be displayed in NX Studio after 

being downloaded to the computer using other applications.

• This option is displayed only if supported applications are installed.

• This option takes effect only if the corresponding option is enabled in the 

application used to download the pictures:

 – Wireless Transmitter Utility: Select [NX Studio] for [Open images with 
this application after transfer].

 – Camera Control Pro 2: Select [Show it with NX Studio] for [When a new 
image is received from the camera].

 – NX Tether: Select [NX Studio] for [Display Pictures After Transfer].
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[Apply Edits to Transferred Pictures]
Enable this option to automatically apply the adjustments last selected in the 

[Adjustments] tab to new pictures downloaded to the same folder.

[Edit Videos]
Edit videos (0 “Video Editing (Movie Editor)”, page 161).

[Launch Picture Control Utility 2]
Launch Picture Control Utility 2. This option is displayed only if Picture Control Utility 2 

is installed.

[Open With]
Open the current picture using other software. Software can be added to the 

menu using [Register].

[Rename]
Rename the current picture.

[Save]
Save changes to image adjustments or XMP/IPTC metadata (0 “[Save]”, page 

284).

[Save As]
Save the current picture under a new name.

[Export]
Export the current picture in a selected format  (0 “Exporting Pictures”, page 

258).

[Upload]
Upload pictures to [NIKON IMAGE SPACE] or [YouTube] (0 “Uploading 

Pictures to the Web”, page 241).

[Eject] [Disconnect] (Windows)/[Eject] (macOS)
Eject removable media. In Windows, this option can also be used to disconnect 

a selected network drive.



291The [File] Menu

[Page Setup]
Adjust printer settings.

[Print]
Print the current picture (0 “Printing”, page 248).

[Exit] (Windows Only)
Exit NX Studio.

 A Epson Printers

If installed, the Epson Easy Photo Print utility or Epson Print Layout plugin can be 

launched from NX Studio.

• Installing Epson Easy Photo Print adds a [Print with E-Photo] option to the 

[File] menu.

• Likewise, installing Epson Print Layout adds a [Print with Epson Print 
Layout] option to the [File] menu.

• [E-Photo] and [Epson Print Layout] icons are also added to the toolbar and 

can be used to launch the corresponding software.
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The [NX Studio] Menu (macOS Only)

[About NX Studio]
View version information.

[Options]
Open the NX Studio options (preferences) dialog (0 “Options”, page 263).

[Quit NX Studio]
Quit NX Studio.
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The [Edit] Menu

[Undo]
Go back one step, undoing the most recent change to the current picture or in 

the current dialog. Changes cannot be undone if the picture is deleted in the 

Explorer or another application during editing.

[Redo]
Redo an operation after performing [Undo].

[Cut]
Remove the selection from its current location and copy it to the clipboard.

[Copy]
Copy the current selection to the clipboard.

[Paste]
Paste the contents of the clipboard in the current location.

[Delete]
Move the current picture or folder to the Recycle Bin (or in macOS, the Trash). 

Choosing this option when a folder is selected in the browser palette [Favorite 
Folders] list removes the selected folder from the favorites list.

[Select All]
Select all pictures or folders.
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[Deselect]
Deselect the currently-selected pictures or folders.

[Select Inverse]
Select all pictures or folders that are not currently selected and deselect any 

pictures or folders that are currently selected.

[Select by File Type]
Select all photos or videos or photos or videos of a chosen file type or types.

[Select by Rating]
Select all photos or videos with a chosen rating or ratings (0 “Rating Pictures”, 

page 66).

[Select by Label]
Select all photos with a chosen label or labels  (0 “Labeling Photos”, page 70).

[Options] (Windows Only)
Open the NX Studio options (preferences) dialog (0 “Options”, page 263).
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The [Browser] Menu

[Go]
Navigate the folder hierarchy.

[Add to Favorites]
Add the current folder to [Favorite Folders] in the browser palette (0 “The 

Browser Palette”, page 17).

[Favorite Folders]
Choose a folder from those listed under [Favorite Folders] in the browser 

palette.

[New Folder]
Create a new folder in the current folder.

[View in Explorer] (Windows)/[View in Finder] (macOS)
Open the current folder in Windows Explorer (Windows) or the Finder (macOS).

[Show Images from Subfolders of Current Folder]
Include pictures in folders under the current folder in thumbnail and filmstrip 

views.
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The [Image] Menu

[Rotate 90° CW]/[Rotate 90° CCW]/[Rotate 180°]
Rotate pictures.

[Rate]/[Choose Label]/[Protection]
Rate, label, and protect or unprotect pictures.

[Sequence]
Perform the following operations on the current sequence.

• [Change Key Image]: Choose the current picture as the key image for the 

sequence.

• [Unsequence]: Remove pictures from the sequence.

[Add to Album]
Add the current picture to a selected album (0 “Collecting Pictures in Albums”, 

page 21).

[Remove from Album]
Remove the current picture from an album.

[Voice Memo]
Start and stop voice memo playback. You can also delete voice memos from 

pictures.

[Convert Motion Snapshot to Video]
Save the current Motion Snapshot as a video.
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[AF Noise Reduction]
Process MP4 or MOV files to reduce the sound made by the camera focusing 

and save the results as a separate file.

[Metadata]
Perform the following operations on metadata.

• [Export File/Photo Info]: Export shooting data for the current picture to a 

text file.

• [Copy File/Photo Info]: Copy shooting data for the current picture to the 

clipboard.

• [Copy IPTC Data]/[Paste IPTC Data]: Copy or paste IPTC data from or to the 

current picture.

• [Import XMP/IPTC Preset]: Import XMP/IPTC presets.

• [Copy Location Data]/[Paste Location Data]: Copy or paste location data 

from or to the current picture.

• [Delete Location Data]: Delete location data from the current picture.

• [Delete Heading]: Delete the compass heading from the current picture.

[Slideshow]
View the pictures in the current selection or current folder as a slide show 

(0 “Slide Shows”, page 236).
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The [Adjust] Menu

[Gray Point Sample Tool]
Click anywhere in the picture to adjust white balance so that the sampled pixel 

takes on a neutral gray color (0 “The White Balance Tool”, page 96).

[Crop Tool]
Crop pictures (0 “Cropping Pictures”, page 134).

[Straighten Tool]
Straighten pictures (0 “The Straighten Tool”, page 139).

[Auto Retouch Brush Tool]
Remove dust and scratches (0 “The Retouch Brush”, page 122).

[Color Control Point Tool]
Enhance pictures using color control points (0 “The Color Control Point Tool”, 

page 125).

[Copy All Adjustments]
Copy all adjustments to the clipboard.

[Paste Adjustments]
Paste adjustments from the clipboard.

[Save All Adjustments]
Save the current settings for all adjustments in an adjustments file.

[Load Adjustments]
Load adjustments from an adjustments file and apply them to the pictures in 

the current selection.
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[Revert to Original State]
Revert all changes and restore pictures to their original state.

[Revert to Last Saved State]
Initialize the adjustments file, cancelling all changes made in NX Studio (0 “The 

Adjustments Manager”, page 154).



300 The [View] Menu

The [View] Menu

[Previous Item]/[Next Item]
Display the next or previous picture in the current folder.

[Viewer]
Choose how pictures are displayed in the view area (0 “Choosing a View Mode”, 

page 36).

[Filmstrip]
Change the orientation of the filmstrip (0 “Filmstrip View”, page 47).

[Full Screen]
Display pictures full-screen (0 “Full-Frame View”, page 49).

[Thumbnail Size]
Choose the size of the thumbnails displayed in thumbnail and filmstrip views.

[Sort Thumbnails By]
Sort thumbnails.
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[Display Thumbnail Info]
Choose whether file names, labels, ratings, icons, and other data are displayed 

on pictures in thumbnail or filmstrip view. Note that regardless of the options 

selected, only labels and file names will be visible when small thumbnails are 

displayed.

[Show RAW and JPEG Pairs as Single Images]
Display each pair of pictures shot in RAW + JPEG format as a single image in 

thumbnail and filmstrip views.

[Show Sequences as Single Images]
Display each sequence of pictures shot using the Smart Photo Selector or in 

continuous release mode as a single image in thumbnail and filmstrip views.

[Zoom Ratio]
Zoom in or out on pictures displayed in the viewer or in “2/4-images” or before-

and-after views.

[Image Information]
Display the camera name, date and time of recording, and other image 

information in the viewer.

[Histogram]
Display a histogram in the viewer. You can also select channels or adjust 

histogram settings.

[Filter]
Filter pictures by label, rating, protection status, or file type.
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[Image Viewer Options]
Adjust viewer display settings.

• [Show Grid]: Display a grid in the viewer.

• [Show Focus Point]: Show the focus point for the current picture.

• [Show Highlights]: Display areas of the picture with the maximum value 

for brightness (255) in any channel and in which details may have been lost 

due to overexposure; different colors are used to indicate highlights for each 

channel (RGB).

• [Show Shadows]: Display areas of the picture with the minimum value for 

brightness (0) in any channel and in which details may have been lost due 

to underexposure; different colors are used to indicate shadows for each 

channel.

• [Show RAW Images]: Display RAW image data in the viewer when NEF/NRW 

pictures are selected. A preview is displayed when this option is not selected.
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[Map Display Options]
Adjust map display settings.

• [Show Track Log]: Load track logs for display on the map (0 “Importing 

Track Logs”, page 220).

• [Open Map in Browser]: Display the position currently shown on the map in 

a web browser using an online map service.

• [Home Location]: Display the home position. The home position can be 

selected using the [Map] item in the [Options] dialog (0 “[Map]”, page 

277).

• [Merge Altitude and Track Logs]: Merge altitude/depth and track logs 

(0 “Adding Altitude/Depth Readings to Track Logs”, page 229).

[Refresh]
Update the display in the viewer or filmstrip.
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The [Window] Menu

[Show Browser Palette]/[Show Adjustments/Info Palette]/[Show Navigation 
Window]/[Show Favorites]/[Shows Albums]/[Show Histogram]

View or hide palettes.

[Show Toolbar]
View or hide the toolbar.

[Customize Toolbar]
Choose the tools displayed in the toolbar. Selected items are displayed.
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The [Help] Menu

[NX Studio Help]
View help.

[Check for Updates]
Check for updates to NX Studio.

[Open NIKON IMAGE SPACE]
Open NIKON IMAGE SPACE in a web browser.

[About] (Windows Only)
View version information.
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